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Welcome to Articulate Presenter 5 Documentation  
 

Articulate® is the global leader in rapid e-learning. Thousands of corporate, government and 
academic customers in more than 50 countries use our powerful, intuitive technologies to train and 
communicate rapidly, widely and effectively. 

We know how people learn. We understand how organizations work. We believe that superior 
learning and communications technology, widely available across your enterprise, provides 
competitive advantage.  

That's what Articulate is all about -- putting the power of rapid e-learning in the hands of anyone 
who needs to share knowledge. Our goal is to ensure that you can train, motivate, inform and 
persuade the people who will move your organization forward.  

 

This documentation always reflects features available in the latest version of Articulate Presenter. 
Current version details can be found on the Articulate Support site. This documentation was last 
updated January 2007. 

Note: If you are using Articulate Presenter Version 4.x, please refer to this documentation. If you 
are using Articulate Presenter Version 3.x, please refer to this documentation.   
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System Requirements 

System requirements for authoring with Articulate Presenter follow: 

Hardware: 

CPU: Pentium II or later 

Memory: 128MB (256MB recommended) 

Available disk space: 25MB 

Multimedia: Sound card (if recording 
Narration) 

Recording Device: Microphone  (if recording 
Narration) 

  

Software: 

Operating 
System: 

Microsoft Windows 98, NT, 2000, XP, or 
2003 

Microsoft 
PowerPoint: 

PowerPoint 2000, PowerPoint 2002 
(PowerPoint XP), or PowerPoint 2003 

Microsoft 
Word (if using 
Publish for 
Word feature): 

Word 2000, Word 2002 (Word XP), or 
Word 2003 

Macromedia 
Flash Player: 

Macromedia Flash Player 6.079 or later 
(http://www.macromedia.com/go/getflash)  

 

Tip:  For the best sound quality, use a USB microphone such as the Plantronics DSP-100 
(details here). 

 

The minimum software requirements for viewing published presentations include the following: 

• Flash Player 6,0,79 or later (http://www.macromedia.com/go/getflash)   

• One of the following browsers: 

 Windows: 

Operating System Supported Browsers 

Windows 98 Microsoft Internet Explorer 5.x, Netscape 4.7, Netscape 
7.x, Firefox 1.x, AOL 8, and Opera 7.11  

Windows Me Microsoft Internet Explorer 5.5, Netscape 4.7, Netscape 
7.x, Firefox 1.x, AOL 8, and Opera 7.11 

Windows 2000 Microsoft Internet Explorer 5.x, Netscape 4.7, Netscape 
7.x, Firefox 1.x, CompuServe 7, AOL 8, and Opera 7.11  

Windows XP Microsoft Internet Explorer 6.0, Netscape 7.x, Firefox 
1.x, CompuServe 7, AOL 8, and Opera 7.11  
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 Macintosh: 

Operating System Supported Browsers 

Mac OS 9.x Microsoft Internet Explorer 5.1, Netscape 4.8, Netscape 
7.x, Mozilla 1.x, and Opera 6  

Mac OS 10.x Microsoft Internet Explorer 5.2, Netscape 7.x, Mozilla 
1.x, AOL 7, Opera 6, and Safari 1.0 (Mac OS 10.2x or 
later only)  

   

  Linux: 

Operating System Supported Browsers 

Linux Konqueror 3.3.1, Mozilla 1.7.3, Firefox 1.x 
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Installing Articulate Presenter 

After you have downloaded Articulate Presenter, run the setup program to install on your 
machine. 

To install Articulate Presenter: 

1. Close all programs. 

2. Double-click on the program setup.exe (exact name may vary). 

3. Follow the instructions on the screen.  

By default, Articulate Presenter is installed in C:\Program Files\Articulate\Presenter. 
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Authoring Your First Presentation 

Authoring your first presentation with Articulate Presenter is fast and easy. Start 
with the Getting Started page, which outlines the easy steps to convert your 
PowerPoint content to compelling Flash, ready to share online.  

 

Please also visit and bookmark Word of Mouth - The Articulate Blog for the latest 
announcements, tips 'n tricks, and more!  

 

 

Note:  When you publish your first presentation, you will be prompted to select either a 
Western or Non-western character set.  For more information, please see Configuring the 
Options - The First Time You Publish. 
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Launching the Program 

After successfully completing the Articulate setup program, you can access the Articulate 
Presenter menu from within PowerPoint. All Articulate authoring functions can be accessed 
through the Articulate Presenter menu. 

To access the Articulate Presenter Menu: 

1. Launch PowerPoint. 

2. Click on the Articulate menu item, located directly to the right of the PowerPoint Help 
menu.  You will see the Articulate Presenter menu displayed. 

3. Please be sure to review Library and Options and Authoring Your First Presentation. 
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Library and Options  

Use Library and Options to set up Logos, Presenters, Playlists, Quality, and Other settings 
for Articulate Presenter. 

To open Library and Options: 

1. From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2. Click Library and Options. 
 

 

3. The Library and Options window will display. 

 

Click one of the five sections to configure the settings. The five sections follow: 
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Logos 

 

Add Click the Add button to add a new logo to your library of logos. 
Supported logo formats are .SWF (Flash), .JPG, .GIF, .BMP, 
.EMF, and .WMF. For best results, use a custom logo with a 
maximum width of 244 pixels.  

Delete Highlight a logo's name in your list and click the Delete button 
to delete the selected logo. You will be asked to confirm your 
choice.  

Make default 
Highlight a logo's name in your list and click the Make default 
button to make the selected logo the default choice.  
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Presenters 

 

 

Managing the Presenter Library 

Add Click the Add button to add a new presenter to your library of 
presenters. See below ("Configuring the Presenter") for specifics 
on inputting presenter's details.  

Edit Highlight an existing presenter's name and click the Edit button 
to edit the selected presenter. See below ("Configuring the 
Presenter") for specifics on editing presenter's details.  

Delete Highlight a presenter's name in your list and click the Delete 
button to delete the selected presenter. You will be asked to 
confirm your choice.  

Make default 
Highlight a presenter's name in your list and click the Make 
default button to make the selected presenter the default 
choice.  
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Configuring the Presenter 

Name The First and Last names of the presenter. 

Title  The Title of the presenter (e.g., Vice President). 

Email The email address of the presenter.  

Presenter Bio A short bio of the presenter. 

Photo 
A photo of the presenter. Click Browse to add or edit a photo. 
Supported image formats include .JPG, .GIF, .PNG, and .BMP. 
 The optimal image size is 73x85 pixels. 

Image Options 
If your photo is not exactly 73x85 pixels, you have two options.  
To maintain the dimensions of your photo, select Maintain 
aspect ratio.  If you would like your photo to stretch to fit the 
entire width of the photo area in the player, select Stretch to 
fit. 

Tip:  The presenter entries will establish the presenters used when you publish. You can 
always add a new presenter when you publish a specific presentation. You can also assign a 
different presenter to each slide of your presentation using the Slide Properties Manager.  

 
  

Playlists 
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New 
Click the New button to create a new playlist. You will be 
prompted to enter the name of the playlist. When you have 
entered the name of the new playlist, click OK to save it.  

Rename 

Click the Rename button to rename the selected playlist. You 
will be prompted to enter the new name of the playlist. When 
you have entered the new name of the playlist, click OK to save 
your changes  

Delete 

Click the Delete button to delete the selected playlist. You will 
be asked to confirm whether you want to delete the selected 
playlist. Click Yes to delete it or No to keep it. 

Add 

Once you've created and named a playlist, click the Add button 
to select a song to add to your playlist. Supported file formats 
include .MP3 and .WAV. 

Remove 

Highlight a song in your selected playlist and click the Remove 
button to remove the song from your playlist. You will not be 
prompted to confirm the removal.  

Up 
Highlight a song in your selected playlist and click the Up button 
to move the song up one position in your playlist.  

Down 
Highlight a song in your selected playlist and click the Down 
button to move the song down one position in your playlist.   

Top 
Highlight a song in your selected playlist and click the Top 
button to move the song to the top position in your playlist.  

Bottom 
Highlight a song in your selected playlist and click the Bottom 
button to move the song to the bottom position in your playlist.  

Loop Playlist 

Check the box next to Loop playlist if you want your playlist to 
loop. The playlist will loop if the total duration of the playlist is 
less than the total duration of the slides to which the playlist is 
assigned. 

Volume level relative to 
narration 

Enter a whole integer to represent the Volume level relative to 
narration of your selected playlist to any audio you record using 
Record Narration or import via Import Audio. For example, 
setting this option to 100% will play your playlist at the same 
volume as your recorded or imported audio, and setting it to 
50% will play your playlist at half the volume of your recorded or 
imported audio. 
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Quality 

 

Optimize for Web 
Delivery 

If you will primarily be publishing presentations that will be 
delivered on a Web server -- on either the Internet or an intranet 
-- then choose this as your default compression setting. 

Optimize for CD-ROM 
Delivery 

If you will primarily be publishing presentations that will be 
delivered via CD-ROM, then choose this as your default 
compression setting. 

Custom (Advanced) 
This option is recommended only for users with advanced 
knowledge of compression settings. The quality factor refers to 
.JPG. A quality factor of 75 is the default image setting when 
using Optimize for Web Delivery.  

   
  

 



Getting Started with Authoring 

13 

Other 

 

Timing Slides without audio or animation display for x seconds 

Set the duration for which slides that are published without any 
audio will be displayed. This value must be greater than 0. 

On mouse click animations without set timings display 
after x seconds 

Set the timing for slides that contain 'mouse-click' animations 
but do not have timings set. 

General Automatically save changes 

This option will automatically save your changes.  It is 
recommended you leave this setting checked. 

Optimize audio volume 

This setting will normalize all audio files. 

Resize slide show window so it is not covered by narration 
recorder 

This option will resize your PowerPoint window and move it to 
the left side of your screen while displaying your Record 
Narration window on the right side of your screen. If you 
uncheck this box, your Record Narration window will appear 
hovering over your PowerPoint window, which will not be 
resized.  
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SWF Options Publish slides at X frames per second 

The default frame rate of the Articulate Player. Note that if you 
import third-party SWF movies, you should ensure that the FPS 
of the inserted movie matches the setting you have here. The 
default setting is 30 FPS. 

Character Set 
This will be the default character set for published presentations. 
If you will be publishing text in English and most Western 
European languages, you should choose Western. If you will be 
publishing text in Asian, Eastern European, or other languages, 
you should choose Non-western.   

Misc 
Prompt before overwriting published folder 

This option determines whether you should be prompted to 
overwrite existing files when publishing to a folder containing a 
previous output.  

Prompt before overwriting project zips 

This option determines whether you should be prompted to 
overwrite an existing project zip file when publishing to a folder 
containing a previous output.  

Launch presentation after publish automatically 

This option determines whether you would like to automatically 
view your output immediately after publishing. 

Enable Publish to Articulate Knowledge Portal 

Knowledge Portal customers: Check this box to allow direct 
publishing to your account. Learn more here. 

  

The First Time You Publish: 

Note that when you publish your first presentation, you will be asked to choose a Character set as 
shown below: 

 

After making your selection, you can always modify the character set in the Other section of 
Articulate | Library and Options, as shown above. 
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Working with Narration and Audio 

Record Narration 

Articulate Presenter makes it simple to add narration to your slides. 

Add narration with the Record Narration Window.   

To open the Record Narration Window: 

1.  From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2. Select Record Narration from the Articulate Menu. 

 

 

 

The Record Narration Window displays in the lower right-hand corner of the screen.  During 
recording, you can drag the Record Narration Window anywhere on the screen. 

Click your mouse on the various elements of the Record Narration Window to explore the functions. 
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To begin recording your narration: 

1. Click on the 'Record' button to start your recording.  You will see the counter begin 
counting. 

2. You can use the 'Pause' button during recording to take breaks. Click 'Record' to resume 
recording.  

3. When you are finished recording your narration for the slide, click Stop Recording. This is 
the same button you clicked to start recording. 

4. Advance to the next slide by clicking on the Next button. 

5. When you are done recording all of your narration, click the Close button. 

Tip:  When slides contain animations, the Record button will display Next Animation. 
 Simply click Next Animation to trigger the animation at the desired time. 

Note:  You can set timings only for "On Mouse Click" animations in the Record 
Narration Window.  By contrast, "Automatic animations" will always respect the timings 
set within the Custom Animation dialog of PowerPoint. 

 

Additional Functions of the Record Narration Window 

Prev / 
Next  

Cue up a specific slide for recording. 

Pause Pause recording or pause playback.  

Play/Stop 
Control audio playback. (Only used when playing back audio, not during audio 
recording.) 

Options 

Record this slide only - records one slide at a time. Uncheck this option to record 
the presentation in continuous mode. 

Show slide notes - shows speaker notes from the slide. 

Show total duration - displays total presentation recording duration beneath the 
slide counter. 

 

Remove recorded narration: 

To remove recorded narration, see Removing Narration and Imported Audio. 
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Importing Audio 

In addition to recording your narration, you can also add narration to your presentation by 
importing audio files.  This may be necessary when you have audio that was previously recorded 
(such as a recorded speech).   

To import audio: 

1. From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2. Click Import Audio. 
 

 

3. The Import Audio window will display: 
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4. Double-click the slide for which you wish to import audio, or click Browse. 

5. Locate the audio file(s) you wish to import and click Open. 

6. Repeat Steps 4 & 5 for all slides for which you wish to import audio and click OK. 

Tip:  You can only import one audio file per slide. If you want background audio, see 
Playlists.  

 

Remove imported audio: 

To remove imported audio see Removing Narration and Audio. 
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Timeline Audio Editor 

The Articulate Timeline Audio Editor gives you precise control over your recorded or imported 
narration, allowing you to edit the audio track for each slide, as well as drag-and-drop markers for 
synchronizing your narration with your animation. You can also import, cut, paste, and delete 
narration with the Timeline Audio Editor.   

To open the Timeline Audio Editor: 

1. From PowerPoint, click Articulate. 

2. Select Timeline Audio Editor from the Articulate Menu. 
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The Timeline Audio Editor will open, showing you the waveforms for each of your slides. 

 

 

 

Details about the audio on each slide are shown at the bottom of the Timeline Audio Editor.  

 

Functions of the Timeline Audio Editor 

Menu 
Bar 
Actions 

Each of the available menu bar buttons are described below: 

Import an existing .WAV or .MP3 file. 

Save your audio file and any changes you've made. 

Undo your last change. 

Cut your selection and copy to the clipboard. 

Copy your selection to the clipboard. 

Paste your clipboard contents. 

Delete your selection. 

Play your audio from the selected point or play current selection. (Click to select starting point or 
click and drag to create selection.) 

Play the current slide. 

Pause playback. 

Resume playback from current position (icon appears after pausing). 

Stop playback. 

Loop playback. 
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Record new audio. 

Zoom in.  

Zoom out. 

Zoom in on selected section. 

Zoom in on current slide.  

Zoom out to view all slides. 

Slide: Use the drop-down menu to select a particular slide. 

Clicking 

Click your mouse in any location to set your editor cursor there. You can press the Play button ( ) 
to play your audio from that location.  

Click and hold, then drag your mouse from left to right or from right to left to highlight any section 
of your audio. You can then do any of the following with your selection: 

• Press the Play button ( ) to play just this section. 

• Press the Copy button ( ) to copy your selection and Paste ( ) it somewhere else in 
this slide or another slide. 

• Press the Cut button ( ) to cut your selection and Paste ( ) it somewhere else in this 
slide or another slide. 

• Press the Delete button ( ) to delete your selection.  

Cut, copy, paste, and delete functions are also accessible via the Edit menu. 

Right-click on the slide header area to add a click in the desired area to specify where the 
animation should occur.  

Tip: You can add on-click markers before adding on-click animations to your slides. For 
example, if you're editing your audio and know that you want an animation to appear at the 
10-second mark, you can add a click in the Timeline Audio Editor first, then add your 
animation in the slide. The timing will be preserved. 

 

File 

Use the File menu for the following commands: 

Import: 

Import an existing .WAV or .MP3 file into your e-learning course or presentation. You can also click 

on the import icon ( ). 

Save: 

Save your work in the Timeline Audio Editor. You can also click on the save icon ( ). 

Exit: 

Exit the Timeline Audio Editor. If you've made any changes, you will be prompted whether or not to 
save your work.  

Edit 

Use the Edit menu for the following commands: 

Undo: 

Undo the last edit or change you made. You can also click on the undo icon ( ). 

Cut: 

Cut the selected audio from its current location and save to the clipboard. You can also click on the 
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import icon ( ). 

Copy: 

Copy the selected audio to the clipboard. You can also click on the copy icon ( ). 

Paste: 

Paste the audio from the clipboard to the designated location. You can also click on the paste icon 

( ). 

Delete: 

Delete the selected audio from its current location. You can also click on the delete icon ( ). 

Select All: 

Select all audio across all slides.  

Volume 

Use the Volume menu for the following commands: 

Maximize: 

Maximize the volume for the selected audio.  

Change: 

Change the selected volume. You will see this controller: 

 

Slide the meter to the desired position and click OK to save your volume change. 

Dynamic Balance: 

Set Dynamic Compress / Expand Parameters. You will see this window: 

 

Specify a Sampling Duration (Seconds) that will be used to adjust the volume of the selected 
audio. Use Target Volume to input your desired adjusted volume. Cut off Volume is to avoid 
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processing silence region so that the noise is not amplified if the original volume is less than this 
percentage.  

View 

Use the View menu for the following commands: 

Zoom In: 

Zoom in incrementally. You can also click on the zoom in icon ( ). 

Zoom Out: 

Zoom out incrementally. You can also click on the zoom out icon ( ). 

Selection: 

Zoom in on the highlighted selection. You can also click on the selection icon ( ). 

Slide: 

Zoom in on the selected slide. You can also click on the view slide icon ( ). 

All: 

Zoom out to show all slides. You can also click on the view all icon ( ). 

Next Marker: 

Highlight the next on-click marker.  

Previous Marker: 

Highlight the previous on-click marker.  

Insert 

Use the Insert menu for the following commands: 

Silence: 

Insert silence beginning where your cursor is. You will be prompted to enter a number of seconds. 
Integers are supported. 

 

Recording: 

Begin recording at the specified location. You will see the following: 
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Click Recording Source & Volume to adjust balance and volume. Click Start to begin recording 
and click Done when you are finished recording.  

You can also click on the record icon ( ).  

 

Note: You can set timings only for On Mouse Click animations. By contrast, Automatic 
animations will always respect the timings set within the Custom Animation dialog of 
PowerPoint. 

 

Keyboard Shortcuts: 

You can use the following keyboard shortcuts in the Timeline Audio Editor: 

Cut: CTRL+X 

Copy:  CTRL+C 

Paste:    CTRL+V 

Delete:    SHIFT+DELETE 

Silence: CTRL+L 

Select All:  CTRL+A 

Undo:  CTRL+Z 

Zoom In:  SHIFT+1 

Zoom Out: SHIFT+2 

View 
Selection:  

SHIFT+3 

View 
Current 
Slide:  

SHIFT+4 

View All:  SHIFT+5 

Play/Pause: 
   

SPACE 

Record:     CTRL+R 

Save:  CTRL+S 
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Removing Narration and Imported Audio 

You can easily remove recorded narration or imported audio from your slides using the Timeline 
Audio Editor. Another simple method for removing audio for an entire slide is the following. 

To remove recorded narration or imported audio: 

1. From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2. Select Import Audio from the Articulate Menu. 

 

 

You will be presented with the Import Audio window below: 
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Highlight the slide for which you want to remove the narration or imported audio and click Remove. 

 

You can also edit or remove audio using the Timeline Audio Editor. 
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Synchronizing Animations 

Sync Animation Timings 

If you wish to edit the timings of your animations, you can accomplish this either with the 
Timeline Audio Editor or with the Edit Animation Timings Window.  This is useful if you are 
satisfied with the audio, but would like to make adjustments to the time line of when the animations 
are displayed. 

To sync animation timings: 

1. From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2. Click Sync Animation Timings. 
 

 

3. The Sync Animation Timings window will display: 
 

 
  

4. Click Start Sync to play the audio. 

5. Click Next Animation to set the new timing for the next animation.  Repeat this step for 
all animations on that slide. 
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6. Select OK when you are done. 

Additional Functions of the Edit Animation Timings Window 

Play/Pause/Stop 
Control the playback of your audio and animations, pause the editing of 
animation timings, and stop editing. 

Options 
Show slide notes - shows speaker notes from the slide. 

Show total audio duration - displays total presentation recording duration. 

Note:  The Sync Animation Timings Window syncs only "On Mouse Click" animations. 
By contrast, "Automatic animations" will always respect the timings set within the Custom 
Animation Window of PowerPoint. 

 

See Timeline Audio Editor for more details on synchronizing your audio and animations.  
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Articulate™ Presenter 5 – PowerPoint Animation Support 

 

ANIMATION SUPPORTED SUBSTITUTION 

   

Entrance Animations:   

Appear Yes  

Blinds Yes Fade 

Box Yes  

Checkerboard Yes Fade 

Circle Yes  

Crawl in Yes  

Diamond Yes Fade 

Dissolve in  Yes Fade 

Flash Once Yes  

Fly in Yes  

Peek in Yes  

Plus Yes Fade 

Random Bars Yes Fade 

Random Effects Yes  

Split Yes  

Strips Yes  

Wedge Yes Fade 

Wheel Yes Fade 

Wipe Yes  

Expand Yes  

Fade Yes  

Fade Zoom Yes  

Faded Swirl Yes  

Ascend Yes  

Center Revolve Yes  

Color Typewriter No  

Compress Yes  

Descend Yes  

Ease In Yes  

Grow &Turn Yes  

Rise Up Yes  

Spinner Yes  

Stretch Yes  



Articulate Presenter v5 Documentation 

30 

Unfold Yes  

Zoom Yes  

Boomerang Yes  

Bounce Yes  

Credits Yes  

Curve Up Yes  

Flip Yes  

Float Yes  

Fold Yes  

Glide Yes  

Light Speed Yes Edge does not skew. 

Magnify Yes  

Pinwheel Yes  

Sling Yes  

Spiral In Yes  

Swish Yes  

Swivel Yes  

Thread Yes  

Whip Yes  

Emphasis Animations:   

Change Fill Color  No  

Change Font No  

Change Font Color  No  

Change Font Size No  

Change Font Style  No  

Change Line Color  No  

Grow / Shrink Yes  

Spin Yes  

Transparency Yes  

Bold Flash No  

Brush on Color Yes  

Brush on Underline No  

Color Blend Yes  

Color Wave Yes  

Complementary Color No  

Complementary Color 2  No  

Contrasting Color No  

Darken Yes  

Desaturate Darken Yes  
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Flash Bulb Yes  

Lighten Yes  

Vertical Highlight Yes  

Flicker Yes  

Grow w/ Color Yes  

Shimmer No  

Teeter Yes  

Blast Yes  

Blink Yes  

Bold Reveal No  

Style Emphasis No  

Wave Yes  

Exit Animations:   

Blinds Yes Fade 

Box Yes  

Checkerboard Yes Fade 

Circle Yes  

Crawl Out Yes  

Diamond Yes Fade 

Disappear Yes  

Dissolve Out Yes Fade 

Flash Once Yes  

Fly Out Yes  

Peek Out Yes  

Plus Yes  

Random Bars Yes  

Random Effects Yes  

Split Yes  

Strips Yes  

Wedge Yes Fade 

Wheel Yes Fade 

Wipe Yes  

Contract Yes  

Fade Yes  

Faded Swivel Yes  

Faded Zoom Yes  

Ascend Yes  

Center Revolve Yes  

Collapse Yes  
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Color Typewriter No  

Descend Yes  

Ease Out Yes  

Grow & Turn Yes  

Sink Down Yes  

Spinner Yes  

Stretchy Yes  

Unfold Yes  

Zoom Yes  

Boomerang Yes  

Bounce Yes  

Credits Yes  

Curve Down Yes  

Flip Yes  

Float Yes  

Fold Yes  

Glide Yes  

Light Speed Yes  

Magnify Yes  

Pinwheel Yes  

Sling Yes  

Spiral out Yes  

Swish Yes  

Swivel Yes  

Thread Yes  

Whip Yes  

Motion Paths*:   

4 Point Star Yes  

5 Point Star Yes  

6 Point Star Yes  

8 Point Star Yes  

Circle Yes  

Crescent Moon Yes  

Diamond Yes  

Equal Triangle Yes  

Football Yes  

Heart Yes  

Hexagon Yes  

octagon Yes  
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Parallelogram Yes  

Pentagon Yes  

Right Triangle Yes  

Square Yes  

Teardrop Yes  

Trapezoid Yes  

Arc down Yes  

Arc Left Yes  

Arc Right Yes  

Arc Up Yes  

Bounce Left Yes  

Bounce Right Yes  

Curvy Left, Curvy Right Yes  

Decaying Wave Yes  

Diagonal Down Right Yes  

Diagonal Up Right Yes  

Down Yes  

Funnel Yes  

Heartbeat Yes  

Left Yes  

Right Yes  

S Curve 1 Yes  

S Curve 2 Yes  

Sine Wave Yes  

Spiral Left Yes  

Spring Yes  

Stairs Down Yes  

Turn Down Yes  

Turn Down Right Yes  

Turn Up Yes  

Turn Up right Yes  

Up Wave Yes  

Zigzag Yes  

Bean Yes  

Buzz Saw Yes  

Curved Square Yes  

Curved X Yes  

Curvy Star Yes  

Figure 8 Four Yes  
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Horizontal Figure 8 Yes  

Inverted Square Yes  

Inverted Triangle Yes  

Loop de Loop Yes  

Neutron Yes  

Peanut Yes  

Plus Yes  

Pointy Star Yes  

Swoosh Yes  

Vertical Figure 8 Yes  

Draw Custom Path Yes  

 
*Motion paths support includes reverse direction and auto-reverse. 

Non-supported effects 

The following effects are NOT supported: 

 Transition effects between slides 

 Chart Effects 

 Text “by letter” or “by word," and In Reverse Order. 

 Repeats 

 PowerPoint sound effects 

 Animated GIFs (alternate recommendation is to convert to .SWF format then insert via 
Articulate -> Insert Flash Movie) 

 Animation using a trigger “Start effect on click of…” 

 Animations contained in the slide master 

 After animation effect options to "Hide After Animation" and "Hide on Next Mouse Click" 

 Timing option to "Rewind when done playing" 
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Adding Quizzes and Learning Games 

Insert Quizmaker Quiz (Must have Articulate Quizmaker) 

You can incorporate your quizzes created with Articulate Quizmaker directly into Articulate 
Presenter.  

 

To insert your .AQP file into Articulate Presenter: 

1. Go to Articulate -> Quizzes and Learning Games -> Insert Quizmaker Quiz. 
                             

2. Select the option to Insert published Quizmaker quiz. (Note that you also have the 
option to Create new Articulate Quizmaker quiz.)  

 

3. Click Browse to locate the .AQP file you published. (Refer to the Articulate Quizmaker 
Documentation for details.) 
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4. Using the drop-down menu next to Once the user has started the quiz, specify whether 
to Require the user to complete the quiz or if User can leave quiz at any time. 

5. In the final steps of the wizard, set up your branching, which determines where your user 
will go if she or he passes or fails (options include closing window, a specific URL, the next 
or previous slide (dynamic), or a specific slide number).    
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6. Click Finish to add the quiz.  

7. Go to Articulate -> Publish to publish your e-learning course or presentation. 

8. When you Publish, you will be able to choose one of two Force quiz options: 

a. Require the user to complete the quiz (default) 

b. User can leave quiz at any time 

9. Specify when The user may view slides after the quiz: 

a. At any time (default) 

b. After attempting the quiz 

c. After passing the quiz 

 

 

After you've inserted an Articulate Quizmaker quiz in your Articulate Presenter e-learning course or 
presentation, you can edit the behavior of the quiz, including branching options, in a similar 
manner. 

To edit your Articulate Quizmaker quiz in Articulate Presenter: 

1. Go to Articulate -> Quizzes and Learning Games -> Insert Quizmaker Quiz. 
                             

2. Select the option to Edit settings for inserted Quizmaker quiz. (Note that this option 
only appears if you've previously inserted an Articulate Quizmaker quiz.) 
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3. Optionally, click Browse to update the .AQP file you're including in your e-learning course 
or presentation.  

4. Using the drop-down menu next to Once the user has started the quiz, specify whether 
to Require the user to complete the quiz or if User can leave quiz at any time. 

5. In the final steps of the wizard, set up your branching, which determines where your user 
will go if she or he passes or fails (options include closing window, a specific URL, the next 
or previous slide (dynamic), or a specific slide number). 

6. Click Finish to update the quiz and/or settings with any changes you've made.  
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Insert Learning Game (Professional Edition Only) 

You can quickly and easily add Learning Games to your e-learning course or presentation. 
 Learning Games are often utilized for knowledge checks.  Learning Games can also be useful just to 
enhance the presentation by making it more engaging and interactive. 

There are three types of Learning Games: 

Learning Game 
Description 

Choices 

Multiple choice and True/False questions.  The user's 
objective is to select the correct answer before time runs out. 
If you will be Tracking Using Quiz Results in an LMS, you 
must choose Choices as your Learning Game. 

Word Quiz 

Similar to a "hangman" format.  The user's objective is to 
reveal the hidden answer before running out of time.  The 
user selects a letter by clicking on it.   

Sequence 
The user's objective is to arrange items in the correct 
sequence before running out of time. 

 

A Learning Game can have an unlimited number of questions.  Once you have created Learning 
Game, a 'Learning Game Placeholder' slide will be inserted into your presentation containing all the 
questions of your Learning Game.  You will be able to view your Learning Game after you have 
published your e-learning course or presentation. 

To add a Learning Game: 

1. Select Articulate from the PowerPoint menu bar. 

2. Highlight Quizzes and Learning Games, then Click Insert Learning Game. 
 

 

3. You will be prompted to Add a new learning game slide or Edit an existing learning 
game slide.  Select Add a new learning game  if you want to create a new one.  Click 
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OK.  (If you have already created an interaction, and want to edit it, choose Edit an 
existing learning game slide and then select the Learning Game name from the drop-
down list.) 

4. The Learning Game Wizard will display. There are four steps in the Learning Game 
Wizard: 

 

Step 1 of 4 - Learning Games Wizard 

 

1. Select a Learning Game type from the drop-down list. 

2. Enter a Title for the Learning Game. It will be helpful later if you provide a unique title for 
each Learning Game. 

3. Check or uncheck Require completion. If checked, users will be required to complete the 
Learning Game before they can continue in the e-learning course or presentation. 

4. Check or uncheck Play audio effects. If checked, users will hear sound effects while 
taking this Learning Game.  

5. Enter a Passing score.  80% is the default. 

6. Enter a Default question time limit for each question. The time limit represents how long 
users will have to answer the question. You can override this value for any specific 
question. The maximum time allowed per question is 10 minutes (600 seconds). Any value 
entered greater than 600 will show 10 minutes.  

7. Click Next.    
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Step 2 of 4 - Learning Games Wizard 

 

1. Choose to display the Standard instructions or to display No instructions. 

2. Choose to display a Custom message.  The custom message can be displayed in 
conjunction with the standard instructions, or without any instructions.  If you check 
Custom Message, be sure to enter your message in the text box. 

3. Click Next. 
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Step 3 of 4 - Learning Games Wizard 

 

1. Click Add to add a new question. 

2. Fill in the questions and answers for the interaction type you selected: 

 

Choices 

 

 

1. Select Multiple Choice or True/False question 
type.   

2. Enter the Question.   

3. Enter up to 5 Answers for Multiple Choice.   

4. Select the Correct answer. 

5. Enter the Question time limit value. 

6. Click Next to add another question or click OK to 
finish adding questions. 

Word Quiz 

1. Enter the Question. 

2. Enter the Answer. 

3. Enter the Question time limit value. 

4. Click Next to add another question or click OK to 
finish adding questions. 
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Sequence 

 

 

1. Enter a question. 

2. Enter the Sequence in correct order.  You can enter 
up to 7 steps. 

3. Enter the Question time limit value. 

4. Click Next to add another question or click OK to 
finish adding questions. 

 

When you are done adding questions, you can edit a question by selecting the question from the list 
and then clicking the Modify button.  You can delete a question by selecting the question and then 
clicking the Remove button.  You can also move a question by selecting the question and then 
clicking the Up/Down/Top/Bottom buttons. 
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Step 4 of 4 - Learning Games Wizard 

 

1. If you'd like to modify the feedback text that displays upon completion of your Learning 
Game, enter it here. 

2. Click Next. 
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Learning Games Wizard - Finish 

 

1. Click Finish to insert the Learning Game into your e-learning course or presentation. A 
Learning Game placeholder slide will be inserted into your e-learning course or 
presentation. (This will be converted to the Learning Game when your e-learning course or 
presentation is published.) 

2. Make sure the Learning Game placeholder slide is located in your e-learning course or 
presentation where you want it to be displayed. Switch to Slide Sorter View to easily move 
it within your e-learning course or presentation. 

Tip: You can copy and paste your Learning Game slide into any other e-learning course or 
presentation. Be sure to copy the slide from Slide Sorter View so that the entire slide is 
copied, and not just objects on the slide. 

 





 

47 

Articulate Engage Interactions 

Articulate Engage Interactions (Must have Presenter 5.1 or later & Articulate Engage) 

You can incorporate your interactions created with Articulate Engage directly into Articulate 
Presenter.  

 

To insert your Engage interaction into Articulate Presenter: 

1. Go to Articulate -> Articulate Engage Interactions.   

2. Select to insert your interaction either as an Interaction Slide or as an Interaction Tab. 
Click your choice using the menu on the left-hand side. 

Interactions Slides: Your interaction will be inserted as an entire slide within your 
Articulate Presenter e-learning course or presentation. Use this option if you want to make 
your interaction, such as a process or timeline, the sole focus of the slide.  

Interaction Tabs: Your interaction will be inserted into a specified slide as drop-down 
reference content within the slide so users can reference the interactive content at any point 
within the course. Perfect for interactive FAQs and glossaries that you want to be accessible 
throughout the e-learning course or presentation. 

3. If you want to insert an Interaction Slide, select the Interaction Slides tab, which is 
selected by default: 
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4. If you want to insert an Interaction Tab, select the Interaction Tabs tab: 
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5. Click Create New to add a new interaction via Engage, or click Add Existing to integrate 
an existing Engage .intr file into Presenter (see charts below below for more details).  

6. If you choose to add an interaction slide, you will see a placeholder slide in PowerPoint.  

7. If you choose to add an interaction tab, you will not see a placeholder slide in PowerPoint, 
but you will be able to confirm the interaction tab and edit it via the Articulate Engage 
Interactions option under the Articulate menu in PowerPoint.  

8. When you are ready to publish your e-learning course or presentation, publish as you would 
normally do by going to Articulate -> Publish. Your Engage interaction will appear in the 
published output. See Publishing Your Presentation for more info on publishing via 
Presenter.    

  

Tip: If an interaction is already published or added to a Presenter project, there is no need 
to republish the interaction to Presenter after an update. Any time a change is made to the 
interaction, the update will republish automatically when you close Engage or republish from 
Articulate Presenter. 

 

After you've inserted your Engage interaction slide or tab in Articulate Presenter, you can edit the 
interaction or the interaction properties at any time.  

To edit your Engage interaction via Articulate Presenter: 

1. Go to Articulate -> Articulate Engage Interactions.   

2. Select either the Interaction Slides tab or the Interaction Tabs tab to view all 
interactions included in your project. 

3. Review the section below to see available elements corresponding to the type of interaction 
you've included.  

4. Optionally, if you choose to add an interaction slide, you will see a placeholder slide in 
PowerPoint, which will display the Interaction Properties (more below) you've selected, 
as well giving you the ability to edit Properties or Edit in Engage by double-clicking the 
corresponding button on the placeholder slide. 
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Elements of the Interaction Slides Section: 

The elements of the Interaction Slides section of the Articulate Engage Interactions 
integration are below.  

Interaction Slides: 

Slide 
Listing 

The area directly beneath the Interaction Slides header displays a listing of interactions 
currently included as slides in your PowerPoint file.  

Create 
New 

Click this button to create a new Engage interaction slide. Here's what to do next: 

1. Select the type of interaction you'd like to create. 

2. Enter the name of the new interaction.  

3. When the Engage authoring interface for the new interaction is launched, create your 
interaction.  

4. When you have finished creating your interaction, click the Save and Return to 
Presenter button to save the new interaction and go back to your Presenter project 
in PowerPoint.  

 

Add 
Existing 

Click this button to add an existing Engage .intr file to your Presenter project as a new slide.  

Remove Highlight the existing interaction slide you'd like to remove and click this button. Note that 
this will only remove your interaction slide from your Presenter project and will not delete the 
interaction file itself.  

Edit 
interaction 
in 
Articulate 
Engage 

Click this button to launch the source Engage .intr file and edit it in Articulate Engage. After 
you've made your changes in the interaction, click the Save and Return to Presenter 
button to save the interaction and go back to your Presenter project in PowerPoint.  
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Interaction Properties: 

Allow user to leave 
interaction 

Select from the drop-down list one of the following, which controls 
when your users can proceed past your interaction slide: 

• After viewing all the steps: This option requires your 
users to view all steps of the interaction before 
proceeding to subsequent slides. This option is selected 
by default. 

• Always: This option will allow your user to leave the 
interaction and visit subsequent slides without necessarily 
viewing all steps of the interaction.  

Show 'Next Slide' 
button 

Select from the drop-down list one of the following, which controls 
if and when the "Next Slide" button will appear in your Engage 
interaction: 

• Show upon completion: This option requires will 
display the "Next Slide" button to your users after 
viewing all steps of the interaction. This option is selected 
by default. 

• Show always: This option will make the "Next Slide" 
button appear throughout your interaction slide.  

• Don't show: This option will never display the "Next 
Slide" button. Your users will need to navigate to the next 
slide using Presenter's forward/back controller.  

Button Label This field allows you to customize the text that appears. "Next 
Slide" is the default text that will be displayed based on the 
options you set above in the Show 'Next Slide' button option. 
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Elements of the Interaction Tabs Section: 

The elements of the Interaction Tabs section of the Articulate Engage Interactions integration 
are below.  

Interaction Slides: 

Tabs 
Listing 

The area directly beneath the Interaction Tabs header displays a listing of interactions 
currently included as tabs in your PowerPoint file.  

Create 
New 

Click this button to create a new Engage interaction tab. Here's what to do next: 

1. Select the type of interaction you'd like to create. 

2. Enter the name of the new interaction.  

3. When the Engage authoring interface for the new interaction is launched, create your 
interaction.  

4. When you have finished creating your interaction, click the Save and Return to 
Presenter button to save the new interaction and go back to your Presenter project 
in PowerPoint.  

 

Add 
Existing 

Click this button to add an existing Engage .intr file to your Presenter project as a new tab.  

Remove Highlight the existing interaction tab you'd like to remove and click this button. Note that this 
will only remove your interaction slide from your Presenter project and will not delete the 
interaction file itself.  

Edit Label Highlight the existing interaction you'd like to rename in the list and click this button to edit 
the name. Note that only the interaction name as it appears in this list will be changed; the 
interaction name itself will not be affected.  

Up/Down 
Arrows 

 

Highlight an interaction tab and use the up and down arrows to change the location of the 
interaction tab relative to other interaction tabs in your e-learning course or presentation. 

Edit 
interaction 
in 
Articulate 
Engage 

Click this button to launch the source Engage .intr file and edit it in Articulate Engage. After 
you've made your changes in the interaction, click the Save and Return to Presenter 
button to save the interaction and go back to your Presenter project in PowerPoint. 
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Incorporating Flash Movies 

Inserting Flash Movies 

Articulate Presenter makes it simple to incorporate previously created Flash movies into your 
presentation. 

You can insert only one Flash movie per slide.  You will be able to view your Flash movie after 
you have published your presentation. 

To add a Flash Movie: 

1.       From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2.       Click Insert Flash Movie. 
 

 

3.       You will be presented with the Flash Movie Wizard, which will walk you through the three 
steps for inserting a Flash Movie.   

 

Step 1 of 3 – Flash Movie Wizard:   
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Flash Movies can be displayed in three different ways: 

Display Type 
Description 

Display in slide 
This will display your Flash movie (.SWF format) in the 
slide panel. 

Display in presenter panel 

This will display your Flash movie (.SWF or .FLV format) 
in the presenter panel of your presentation. In order to avoid 
scaling, Articulate recommends that your .FLV video be no 
more than 233 pixels wide. 

Display in new browser 
window 

This will cause a new window to open independently of your 
slide.  Your Flash movie (.SWF format) will be displayed 
within this new window. 
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 Step 2 of 3 – Flash Movie Wizard:   

 

 

On this page you will enter the location (path) to your Flash movie.  This can be accomplished 
in two ways: 

          If you know where your movie is located, you can type the path manually. Make sure 
to type the full path name to your .swf file. Example: ‘C:\Folder Name\My Flash 
Movie.swf’. 

          Click the Browse button.  You will be presented with a standard Open dialog box. 
Simply browse to the location of your movie and select it. 

When you are finished setting these options, click Next to continue. 

Step 3 of 3 of the Flash Movie Wizard offers different configuration options depending on 
how you have chosen to display your Flash movie.   

• If you have chosen to Display in slide, refer to Configuring Flash Movie in Slide.   

• If you have chosen to Display in presenter panel, refer to Configuring Flash Movie 
in Presenter Panel.   

• If you have chosen to Display in new browser window, refer to Configuring Flash 
Movie in new browser window. 

 

Tip:  If you update your Flash movie after you have published your presentation and you 
want to incorporate your changes into your presentation, simply save the updated .swf file in 
the same location with the same name.  Then publish your presentation again.  Your changes 
will be incorporated.  You can also edit or delete your Flash movie by right-clicking the 
inserted placeholder and choosing the appropriate action from the Articulate menu. 
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Configuring Flash Movie in Slide 

If you have chosen to Display in Slide in Step 1 of 3 in the Insert Flash Movie Wizard, 
complete the following steps to finish the configuration of your Flash Movie. 

Step 3 of 3 – Flash Movie Wizard: 

The first setting you see on this page is Synchronization. The Synchronization option you select 
here determines other behavior for the Flash movie and slide. 

Synchronization: Select the item that best matches the characteristic of your Flash movie: 

1. Play Flash movie and slide in sync: Select this item for Flash movies that have defined 
beginning and end points such as videos, screen recordings and many simulations.  This 
item will automatically set the slide length to match the length of the Flash movie. You will 
also be able to play/pause and seek within the Flash movie using the Articulate Player 
controls. 

 

a. Choose whether the slide will automatically advance to the next slide when the movie 
finishes, or if the user must click the next button. 

b. You can also set a buffer duration (in seconds) before the movie begins playing. Usually 
the default setting is appropriate. 

2. Play Flash movie after slide has begun: Select this item for highly interactive Flash 
movies that don’t have a clearly defined end point such as interactive "click and explore" 
movies. 
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a. Choose when (in seconds into the slide) the Flash movie will first display on screen. 
By default, the movie will display immediately. 

b. Choose whether Articulate Player controls can control inserted Flash movie. 

c. Choose whether the slide will automatically advance to the next slide when the slide 
finishes, or if the user must click the next button. 

 

When you are finished setting the options on this page, click Next to continue. 
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Flash movie Wizard:  Finish 

 

 

If you are satisfied with your settings, click Finish to insert the Flash movie into your 
presentation. You will see a placeholder that contains the first frame of your Flash movie. 

You will be able to view your Flash movie when your presentation is published. 
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Configuring Flash Movie in Presenter Panel 

If you have chosen to Display in presenter panel in Step 1 of 3 in the Insert Flash Movie 
Wizard, complete the following steps to finish the configuration of your Flash Movie. 

Step 3 of 3 – Flash Movie Wizard: 

 

On this page there is one option:  

Move to next slide automatically when movie finishes: This controls whether the 
slide in which you inserted your Flash movie will advance automatically after the Flash 
movie appears, or if the user must manually advance the slide. The default (option is 
checked) is to allow the slide to advance automatically. If you prefer that your users 
advance the slide manually after the movie has completed, uncheck this option.  

When you are finished setting the options on this page, click Next to continue. 
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Flash movie Wizard: Finish 

 

 

If you're inserting a Flash movie (.SWF), the first frame of the movie will be displayed as a 
placeholder in the upper left-hand corner of the slide.  

If you're inserting a Flash video (.FLV), a small icon will be inserted on the upper left-hand 
corner of the slide. You can position this icon anywhere on the slide. The icon is for your 
reference only to indicate that a Flash video has been inserted in the presenter panel. The icon 
will not appear when the presentation is published. You will be able to view your Flash video 
when your presentation is published. 

If you are satisfied with your settings, click Finish to insert the Flash movie into your 
presentation. 
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Configuring Flash Movie in New Browser Window 

If you have chosen to Display in new browser window in Step 1 of 3 in the Insert Flash 
Movie Wizard, complete the following steps to finish the configuration of your Flash Movie. 

Step 3 of 3 – Flash Movie Wizard: 

 

On this page there are three options:  

1.       Size. This will determine the dimensions of the browser window in which your Flash 
movie will appear. The initial dimensions will default to the size of your Flash movie, but 
if you desire a custom size, you can enter those dimensions here.  Regardless of which size 
you choose, a new browser window will open independently of your slide. You have five 
choices for the size of your Flash movie: 

• Full Screen. The browser window containing your Flash movie will occupy 
the entire screen. 

• 640x480. The browser window containing your Flash movie will be 640 
pixels wide by 480 pixels tall. 

• 800x600. The browser window containing your Flash movie will be 800 
pixels wide by 600 pixels tall. 

• 1024x768. The browser window containing your Flash movie will be 1024 
pixels wide by 768 pixels tall. 

• Custom. This will allow you to set the browser window containing your Flash 
movie to specific dimensions.  If you desire dimensions larger than 1600 pixels 
wide by 1200 pixels wide, it is recommended that you choose Full Screen. 

2.       Show Flash movie after: 0 seconds. This allows you to determine how soon after your 
slide loads that the browser window containing your Flash movie appears.  If you would 
like there to be a delay, enter the number of seconds you want the delay to be.  The default 
is 0 seconds, which means that the browser window containing your Flash movie will 
appear immediately. 
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3.       Set this slide’s navigation to advance by user.  This controls whether the slide in 
which you inserted your Flash movie will advance automatically after the Flash movie 
appears, or if the user must manually advance the slide. The default is to let the user 
advance the slide. It is recommended to allow the user to advance the slide so the user can 
have a chance to view the Flash movie. If you prefer to have the slide advance 
automatically, simply uncheck this option, but keep in mind that the user may not have had 
a chance to view the Flash movie. 

When you are finished setting the options on this page, click Next to continue. 

Tip: For best results, instruct your users to disable any pop-up blockers before viewing 
your content.  

 

 
 

Flash movie Wizard:  Finish 

 

 

A small icon will be inserted on the bottom right-hand corner of the slide.  You can position this 
icon anywhere on the slide.  The icon is for your reference only to indicate that a Flash movie 
has been inserted.  The icon will not appear when the presentation is published. You will be able 
to view your Flash movie when your presentation is published. 

If you are satisfied with your settings, click Finish to insert the Flash movie into your 
presentation. 
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Optimizing Flash Movies  

The Articulate Player consists of a single Flash file that is made up of user interface elements and 
several core engine modules, which control and extend the player’s functionality.  

Each slide in a presentation is loaded as an individual external Flash asset, and these can be 
augmented with any SWF format file the user chooses. Embedded SWF files are supported in the 
player in this fashion. There are certain guidelines to be considered when embedding your own SWF 
files. These guidelines are covered below. 

  

General Guidelines for Articulate Presenter 5  

The general guidelines for the embedded movies follow: 

 Set your maximum canvas size to 720x540. 

 Avoid use of _level0 or absolute movie clip references. References to _root are permissible, 
but strongly discouraged. Use relative paths (_parent) in your movie clip references 
instead. 

Articulate Presenter Player SDK: 

Join the Platinum Membership Plan and receive the Articulate Presenter Player Software 
Developer’s Kit (SDK), which provides Flash developers with runtime API hooks, as well as the 
ability to author custom player tabs and tools. Learn more about the Platinum Membership Plan.  
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Using Web Objects 

Inserting Web Objects 

A Web Object, simply put, is any content that can be contained in a Web page.  Web Objects can 
be used for inserting existing Web pages into your presentation, thereby allowing you to leverage 
previously created content.  For example, you can integrate your company’s intranet, or incorporate 
a Web page that contains video, animation, assessments, or any other content relevant to your 
presentation.  You can also insert an entire pre-existing Web site into your presentation, as well as 
movie files. 

Web Objects can be displayed in two different ways: 

Display Type 
Description 

In Articulate Player 
This will insert your Web Object directly within your slide.  
You can think of this method as inserting a mini browser 
within your slide from which your viewer will see the Web 
content. 

In New Browser Window 
This method will cause a new browser window to open 
independently of your slide. 

 

Regardless of which display type you choose, your viewers will be able to interact with your Web 
Object just as they would from a Web browser.   You can insert only one Web Object per slide.  
You will be able to view your Web Object after you have published your presentation. 

To add a Web Object: 

1.       From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2.       Click Insert Web Object. 
 

 

3.       You will be presented with the Web Object Wizard, which will walk you through the three 
steps for inserting a Web Object.  Click Next to continue. 
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 Step 1 of 2 - Web Object Wizard:   

 

 

On this page you will see two options:  

1.       Web address.  This is where you enter the address (URL) of your Web Object; you can 
enter the Web address in one of two ways depending on the type of Web Object you are 
inserting: 

• To create a Web Object based on a link to an existing URL, type the URL manually.  
You can also use Windows’ shortcut keys to copy (CTRL-C) and paste (CTRL-V) the 
URL. 

• If the Web Object you want to insert is a pre-existing Web site stored locally on your 
computer, and you want to insert the entire site into your presentation instead of 
linking to the site, you can browse to locate the folder containing the site and select the 
folder.  The folder must contain an index.htm or an index.html file.  

Tip: To insert a QuickTime or Windows Media Player file, create a folder to contain your 
movie and within this folder create an index.htm or index.html file to launch your movie. 
Insert your movie as if you are inserting a pre-existing Web site, as described above. Click 
here for more details.  

 

2.       Display.  This is where you determine how you want your Web Object to display in your 
presentation.  To choose a display setting, click the down arrow under Display, as shown 
below, and select either “In Articulate player,” or “In new browser window.” 
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If you choose to display your Web Object in the Articulate Player, a Web Object 
placeholder will be inserted on your slide.  Your Web Object, when published, will appear 
inside this placeholder. You may position this placeholder anywhere on the slide that you 
want your Web Object to appear. 

If you choose your Web Object to display In new browser window, no Web Object 
placeholder will be inserted, but an Internet Explorer icon will be inserted on the bottom 
right-hand corner of the slide.  You can position this icon anywhere on the slide.  The icon is 
for your reference only to indicate that a Web Object has been inserted.  It will not appear 
when the presentation is published. 

When you are finished setting these options, click Next to continue. 

Step 2  of the Web Object Wizard offers different configuration options depending on 
how you have chosen to display your Web Object.   

• If you are displaying In Articulate Player, please see Configuring Web Object 
In Articulate Player.   

• If you are displaying In new browser window, please see Configuring Web 
Object In new browser window.   
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Configuring Web Object In Articulate Player 

If you are displaying your Web Object in Articulate Player, complete the following steps to finish 
the configuration of your Web Object. 

Step 2 of 2 - Web Object Wizard: 

 

On this page there are three options: 

1.       Size. This will determine the initial dimensions of your Web Object.  After inserting your 
Web Object you can always resize the Web Object placeholder to your desired 
dimensions before publishing.   You have four choices for the size of your Web Object: 

       Full Slide. If choosing Full Slide, your browser window will display with no navigation 
bars or menus.  

       640x480. This will configure the Web Object to be 640 pixels wide by 480 pixels tall. 

       320x240. This will configure the Web Object to be 320 pixels wide by 240 pixels tall. 

       Custom. This will allow you to set your own dimensions.  Note: You cannot display a 
Web Object in the Articulate Player with a width greater than 720 pixels or a height 
greater than 540 pixels.  If this is desired, it is recommended that you choose to 
display your Web Object in its own window. 

 

Tip: In addition to resizing your Web Object after it is inserted, you can reposition it 
anywhere on the slide. 

 

2.       Show Web Object after: 0 seconds.  This allows you to determine how soon after your 
slide loads during the presentation that your Web Object appears.  If you would like there 
to be a delay between your slide loading and your Web Object appearing, enter the 
number of seconds you want the delay to be.  The default is 0 seconds, which means that 
your Web Object will appear immediately. 
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3.       Set this slide’s navigation to advance by user.  This controls whether the slide will 
advance automatically after the slide completes, or if the user must manually advance the 
slide.  The default is to let the user advance the slide.  It is recommended to allow the user 
to advance the slide so the user can have a chance to interact with the Web Object.  If 
you prefer to have the slide advance automatically, simply uncheck this option; by doing 
so, bear in mind that the user may not have had a chance to view the Web Object’s 
content. 

When you are finished setting the options on this page, click Next to continue. 

 

 
 

Web Object Wizard:  Finish 

 

 

If you are satisfied with your settings, click Finish to insert the Web Object into your 
presentation.  You will be able to view your Web Object when your presentation is published. 
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Configuring Web Object In New Browser Window 

If you are displaying your Web Object in new browser window, please complete the following 
steps to finalize the configuration of your Web Object. 

Step 2 of  3 - Web Object Wizard: 

 

On this page there are three options:  

1.       Size.  This will determine the dimensions of the browser window in which your Web 
Object will appear.  Regardless of which size you choose, a new browser window will open 
independently of your slide.  You have five choices for the size of your Web Object: 

• Full Screen. The browser window containing your Web Object will occupy the 
entire screen. 

• 640x480. The browser window containing your Web Object will be 640 pixels 
wide by 480 pixels tall. 

• 800x600. The browser window containing your Web Object will be 800 pixels 
wide by 600 pixels tall. 

• 1024x768. The browser window containing your Web Object will be 1024 
pixels wide by 768 pixels tall. 

• Custom. This will allow you to set the browser window containing your Web 
Object to specific dimensions. 

2.       Show Web object after: 0 seconds.  This allows you to determine how soon after your 
slide loads that the browser window containing your Web Object appears.  If you would 
like there to be a delay, enter the number of seconds you want the delay to be.  The default 
is 0 seconds, which means that the browser window containing your Web Object will 
appear immediately. 

3.       Set this slide’s navigation to advance by user.  This controls whether the slide in 
which you inserted your Web Object will advance automatically after the Web Object 
appears, or if the user must manually advance the slide. The default is to let the user 
advance the slide.  It is recommended to allow the user to advance the slide so the user 
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can have a chance to navigate around the Web Object.  If you prefer to have the slide 
advance automatically, simply uncheck this option; by doing so, bear in mind that the user 
may not have had a chance to view the Web Object’s content. 

When you are finished setting the options on this page, click Next to continue. 

Tip: For best results, instruct your users to disable any pop-up blockers before viewing 
your content.  

 
 

Step 3 of 3 - Web Object Wizard:  

 

 

These settings are useful in limiting what actions a user can perform from within the Web 
Object. The default is to allow the user to resize the window and to scroll around; these 
settings are useful so that the user can view the entire content of the Web Object, while 
restricting the user’s ability to surf to Web pages that may not be relevant to the presentation.  
The browser window settings from which you can choose are identical to those found in Internet 
Explorer. 

 

Tip:  If the content of your Web Object does not fully fit into the size window you have 
chosen, make sure Show scroll bar is checked so the user can navigate around the Web 
Object; otherwise the user may not be able to see all the content. 

 

When finished making your selections, click the Next button to continue. 
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Web Object Wizard:  Finish 

 

 

If you are satisfied with your settings, click Finish to insert the Web Object into your 
presentation. You will be able to view your Web Object when your presentation is published. 
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Troubleshooting Web Objects 

  

Web Object is not opening in a new window when viewing presentation. 

 
Popup blocking software can cause problems when viewing presentations that contain Web objects 
configured to appear in a new browser window. If using popup blocking software, it is recommended 
that the domain from which the presentation is being launched be added as a safe domain so no 
functionality is lost. 

  

I am trying to insert a Web Object but I am receiving an error message: “Unable to get reference to the 
active slide.” 

 
Make sure that you have the slide selected in the Slide Pane and not in the Outline Pane before 
inserting the Web object. 
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Attachments 

Attachments 

Attachments are resources you want to make available to your viewers during playback of your 
presentation.  The Attachments will be accessible by your viewers when they click the 
Attachment button. 

You can add two types of Attachments: 

Attachment Type 
Description 

Link 
A link to a URL (Web page) that you want to make available 
to your viewers during playback.  An example would be your 
company Web site or that of a partner. 

File 
Any file, like a Word document or PDF, that you want to 
make available for download during playback. 

 

To add an Attachment: 

1. From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2. Click Attachments. 

 

3. You will be presented with the Attachments dialogue box where you will provide 
information about the type of Attachment you are inserting and its location.  

 

Tip: You can add up to 50 Attachments. This can be any combination of links or files. 
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Attachments: 

 

 

On this page there are three options:  

1. Title. This is the title of your Attachment as it will be seen in the Attachment tab within the 
published presentation. 

2. Type. Here you choose the type of attachment you are inserting, Link or File.  Link is the 
default.  To choose File, click the down arrow next to Type and select File.  

3. Path.  When link is chosen as the attachment type, the Path will automatically include 
http://. Simply type the URL (Web address) after http://.  If you have chosen File as your 
attachment type, the http:// will be removed from the Path and the ellipsis to the right of 
Path will no longer be grayed out. Click on the ellipsis to browse to the location of the file 
you want to insert as an attachment. 

When you are finished making your selections, click OK. 
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Slide Properties 

Slide Properties Manager 

You can manage the following elements with the Slide Properties Manager: 

• PowerPoint Slide Title 

• Display in Navigation as 

• Level 

• Change View To 

• Presenter 

• Audio Playlist 

• Move to Next Slide 

 

To open Slide Properties Manager: 

Click Slide Properties Manager from the Articulate menu in PowerPoint. 
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The Slide Properties Manager will display: 

 

 

The presentation or e-learning course Title appears in the upper left-hand corner of the Slide 
Properties Manager; this title is generated from your file name. The total number of slides and the 
Total Duration of your presentation or e-learning course are displayed in the upper right-hand 
corner of the Slide Properties Manager; these details are automatically calculated by Articulate 
Presenter.  

The number in the first column of the Slide Properties Manager corresponds to the slide number in 
PowerPoint.  

Details on other elements of the Slide Properties Manager are outlined below:  

 

Type The icon in the Type column represents the type of content on the slide: 

PowerPoint slide 

 Inserted Flash Movie slide 

 Web Object slide 

Articulate Quizmaker slide 

Learning Game slide 

 

PowerPoint 
Slide Title 

This is the title of your PowerPoint slide, which is automatically taken from the title 
used in your slide. To edit this, you must do so in your slide. You cannot edit this 
field in the Slide Properties Manager.  

Display in 
Navigation 

This is the title of the slide you would like to appear in the Articulate Player 
navigation. To edit this title, click on the field and type your desired slide title. This 
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as field can be different from PowerPoint Slide Title.  

Level The hierarchical or nested level of the slide relative to others, where 1 is the base or 
default level. To edit the level, click in the field corresponding to a slide and select 
the desired level for the slide. Available levels will increase by 1 each time you add a 
new level. For example, when you first assign levels to a presentation or e-learning 
course, you will only have the option to assign a level of 1 or 2 (your first slide must 
be level 1). Once you've assigned a level of 2 to any slide, then you can assign 
subsequent slides to level 3, and so on. You can add as many slide levels as you'd 
like.  

Note that this feature is available only in the default Group by Slide number view. 

Change 
View To 

Use this field to automatically change the view of your presentation or e-learning 
course on a per-slide basis. Available options include the following:  

• [Blank]: By default, the view will not change from the previous slide. If it's 
the first slide, it will display the view you've specified in the Player Template 
Builder for your selected template.   

• Standard: The selected slide will switch to the standard view.  

• No sidebar: The selected slide will switch to a view with no sidebar.  

• Slide only: The selected slide will switch to the slide only view.  

Presenter This is the presenter you would like associated with the selected slide. To choose 
from available presenters, click on the field and select from the drop-down menu 
your desired presenter's name. Presenters can be managed in Library and Options.  

Audio 
Playlist 

This is the playlist you would like associated with the selected slide. To choose from 
available playlists, click on the field and select from the drop-down menu your 
desired playlist's name. Presenters can be managed in Library and Options.  

Move to 
Next Slide 

Use this setting to determine whether this slide should advance automatically to the 
next slide, or whether the user will need to click to advance. To edit your preference, 
click on the field and select from the drop-down your preferred method.  

Group by Use the Group by drop-down to select how to sort the Slide Properties Manager. 
Available options include the following: 

• Slide number (default): Lists slides in slide order 

• Advance mode: Groups slides according to Move to Next Slide setting 

• Playlists: Groups slides according to playlist used 

• Presenters: Groups slides according to presenter used 

• Type: Groups slides according to type of slide 

• View mode: Groups slides according to Change View To setting  
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Hide in 
Navigation 
Panel 

You can choose to hide any slide in the Articulate Presenter navigation by right-
clicking on any slide and selecting the option to Hide in Navigation Panel.  

 

Note that this will only hide the slide from navigation and not from the course or 
presentation itself. Users will still be able to navigate to the slide unless you've 
created your own link-based navigation in your slides and have disabled keyboard 
shortcuts.  
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You can select multiple slides by shift-clicking on one or more rows. Then you can right-click to 
adjust the property assignments for the selected slides. For example, you can change the 
Move to Next Slide setting for a selected group of slides to Automatically by using this method.  
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Player Templates 

Player Template Builder 

In Articulate Presenter 5, nearly every element of the Articulate Player can be customized. With so 
many customization options, it is useful to have a way to save and quickly apply pre-configured 
player options. Player Templates provide this ability. 

The Player Template Builder is a simple tool for creating and editing Templates that customize 
the Articulate Player. Templates are pre-configured player options, which provide a quick and 
convenient way to apply a set of customizations to the Articulate Player. Templates are very useful 
in corporate settings that require standardization of the Articulate Player. 

 

To manage Player Templates: 

1. From within PowerPoint, click Articulate to open the Articulate Presenter menu. 

2. Click Player Template Builder. 

 

 

 

3. The Player Templates Builder will appear. 

  

  

Master Templates: 

Articulate Presenter comes with four pre-configured Master Templates: 

 Corporate Communications 

 E-Learning Course (Single-level) 

 E-Learning Course (Multi-level) 

 Tradeshow Loop 
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To publish a presentation based on a Master Template, select from the drop-down menu your 
desired template. When you select a Master Template, you can click the Preview button to view 
what this template will look like when published. You can click the Preview button at any time while 
customizing a template.  

If, after you select a Master Template, you make custom configurations to the template and click 
the Close button, you will be prompted with the following message: 

 

 

If you want to save your configuration changes, click Yes and, when prompted, enter a name for 
the new template and click OK.  This is to avoid overwriting a default Master Template. 

 

The File drop-down menu allows you to manage your templates with the following commands: 

• New: Create a new template 

• New from existing: Create a new template using an existing template as the base. 

• Save: Save changes to the current template. 

• Save As: Enter a new name for the current template or save a copy of it with a new name. 

• Delete: Delete the current template. You will be prompted to confirm.  

 

Creating a new template: 

If you want to create a new template, select New from the File drop-down menu. You will be 
prompted to enter the name for your new template as shown below. 

 

 

Enter the name for your new template and click OK. Customize your template as desired. For more 
information on customization options, see the next several sections of this chapter. When you are 
finished making your customizations, click the Close button. You will be prompted with a message 
asking if you want to save your changes. Click Yes to save your template, or click No to cancel 
changes. 

The above process is the same if you choose to create New from existing.  
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Editing Templates: 

To edit an existing template, simply click the drop-down box and select the template you would 
like to edit.  Modify your template as desired.  For more information on customization options, see 
the next several sections of this chapter. When you are finished making your modifications, click the 
Close button. You will prompted with a message asking if you want to save your changes. Click Yes 
to save your template, or click No to cancel changes. 

Deleting Templates: 

To delete an existing template, simply click the drop-down box and select the template you 
would like to delete. After you have selected your template, select Delete from the File drop-down 
list. You will be prompted with a message asking if you wish to delete your template. Click Yes to 
delete your template, or click No to cancel deleting. 
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Layout 

When you first open the Player Template Builder, you will see the Layout section. Details of this 
section are below. When you close the Player Template, the last-viewed section will be shown the 
next time you open it.  

 

  

Elements of the Layout Section: 

The elements of the Layout section of the Player Template Builder are below. Use the checkbox 
next to each element to determine if this element should be available in your player template.  

 

View Modes: 

Standard view With this display mode, all elements of the player are visible, unless 
explicitly turned off. 

No sidebar view With this display mode, the sidebar is not visible. The sidebar 
consists of Logo, Info/Presenter, and Navigation Panel. 

Slide only view With this display mode, the only item that is visible is the 
PowerPoint slide. 

Set as starting View: Highlight the mode in which you would like the Articulate Player to start 
when launched and click this button. Each template must have at least one view.  

 

Panels: 

Display logo panel Display/hide the panel in the Articulate Player that can contain a 
company logo. 

Display presenter panel Display/hide Name, Title, and Company fields.  

Display navigation 
panel 

Display/hide the navigation panel. The navigation panel consists 
of the Titles, Thumbnails, Search, and Notes tabs: 

Title: The slide titles as configured in PowerPoint or Slide 
Properties Manager. 
Thumbnails: Thumbnails of the slides in your presentation. 
Useful for visually navigating through your presentation. 
Search: Clicking on this tab reveals a search function, which 
allows your presentation to be searched for those slides 
containing a specific search term. 
Notes: A tab containing any presenter notes for your 
presentation.  
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Navigation Tabs: 

Outline tab Display/hide the outline of slide titles. By default, this is the starting 
tab.  

Thumbnails tab Display/hide the thumbnails tab.  

Notes tab Display/hide the presenter notes tab. 

Search tab Display/hide the search tab. 

Set order of tabs: Highlight a tab name and use the up/down arrows to move the tab 
corresponding to the location in which you would like it to appear. For example, the tab in the top 
position will appear as the first tab on the left in the Articulate Player, and the tab in the bottom 
position will appear as the last tab on the right.  

Set As Starting Tab: Highlight a tab name and click this button to make it the active tab when 
your presentation or e-learning course is viewed in the Articulate Player.  

 

Toolbar Menu: 

Enable attachments tool Display/hide the button for accessing attachments to your 
presentation. 

Enable bookmark tool Display/hide the button that allows your presentation to be 
bookmarked. 

Enable send link tool Display/hide the button that allows a link to your presentation to 
be emailed. 

Enable exit tool Display/hide the exit link in the Articulate Player. 

 

Player Controls: 

Display volume control Display/hide the volume control in the Articulate Player. 

Display 
forward/back/pause 
controller 

Display/hide the navigation controls in the Articulate Player. 

Display seekbar Display/hide the seekbar in the Articulate Player. 

Allow user to seek 
within seekbar 

Control whether or not users can navigate within a slide using the 
seekbar.  

 

Slide Titles: 

For long slide titles Click the radio button that describes how you would like long slide 
titles to display in the Articulate Player navigation: 

Display tooltip after X seconds: 
If the slide title goes beyond available space in the navigation, 
hovering your mouse over the title for this number of seconds will 
display the full title.  

Wrap title up to a maximum of X characters: 

Specify the maximum number of characters that should be shown 
in the slide title. If you have opted to display slide numbers (see 
below), those characters will count toward the maximum.  

Display slide numbers 
in navigation tabs 

Display/hide slide numbers in the Outline and Thumbnails tabs. 
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Navigation  

Use the Navigation section of the Player Template Builder to configure options for user 
navigation within the Articulate Player. Details of this section are below. When you close the Player 
Template, the last-viewed section will be shown the next time you open it.  

 

 

 

Elements of the Navigation Section: 

The elements of the Navigation section of the Player Template Builder are below. Use the radio 
button or checkbox next to each element to determine navigation attributes.  

 

Navigation Restrictions 

User navigation is 

Select the radio button that describes desired user navigation. 

Free - user can view slides in any order: 

The user is free to view the slides in any order.  

Restricted - user can view only current and previous slides: 

The user can only view slides that have been previously viewed.  

Locked - user cannot change slides: 

The user cannot change slides - all slides are viewed in order.  
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Level Expansion Settings 

Expand behavior 

Select the radio button that describes desired level expansion settings. 
These settings are only relevant if your presentation or e-learning 
course contains more than 1 level, as defined in the Slide Properties 
Manager. 

Expand level when the user reaches heading: 

Automatically expands sub-levels when the user reaches the parent 
slide.  

Expand level when the user is inside level: 

Automatically expands sub-levels when the user reaches the first sub-
level beneath the parent slide.  

Don't automatically expand level: 

Sub-level slides are displayed in the slide area, but the titles are not 
automatically shown in the navigation; the user has to manually 
expand the level to view the sub-level slides.  

Expand restrictions 

Select the radio button that describes desired expansion restrictions. 
These settings are only relevant if your presentation or e-learning 
course contains more than 1 level, as defined in the Slide Properties 
Manager. 

Levels can be expanded anytime: 

User can manually expand levels anytime during playback.  

The level cannot be expanded until the user reaches the 
heading: 

User can manually expand levels only when viewing the parent level.  

The level cannot be expanded until the user is inside the level: 

User can manually expand levels only when viewing sub-levels of a 
parent level.  

 

 

Miscellaneous  

Prompt to resume 
on presentation 
restart 

Whether or not the user should be prompted to resume the 
presentation or e-learning course from where he or she left off last 
time. Author should uncheck the resume option when publishing to an 
LMS, or if users are sharing the same machine. 

Automatically scroll 
navigation to keep 
up with 
presentation 

Whether or not the slide navigation should automatically scroll to 
display slide titles corresponding to the current slide being viewed.  

Enable keyboard 
shortcuts 

Controls whether the following Player keyboard shortcuts should be 
available to viewers of your published presentation in the Articulate 
Player:   

• Play Previous Slide: Arrow Left, Arrow Up, or Page Up  
• Play Next Slide: Arrow Right, Arrow Down, or Page Down  
• Play First Slide: Home key  
• Play Last Slide: End key  
• Play/Pause: Spacebar  
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• Select Tabs - Outline, Thumbnails, Search: O / T / S  
• Toggle Slide Notes: N  
• Toggle Display View Modes: V  
• Toggle Bio Button: B  
• Toggle Email Button: E  
• Toggle Audio Mute: M 
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Text Labels 

Use the Text Labels section of the Player Template Builder to change the text for any elements 
of the Articulate Player you choose to display. Details of this section are below. When you close the 
Player Template, the last-viewed section will be shown the next time you open it.  

 

 

 

The column on the left, Buttons/Messages, contains a description of the element (a button or tab) 
for which you can change the text. The column on the right, Custom Text, contains the actual text 
that will appear for an element. To change text that you want to appear for an element, simply click 
in the row for that element in the Custom text column. Next, type the text you want to appear. 
When you are finished customizing your text, click OK. 

 

Tip:  Visit the Player Text Labels entry in Word of Mouth - The Articulate Blog for ideas on 
how to leverage this feature. 
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Colors  

Use the Colors section of the Player Template Builder to modify the color of a particular 
template. Details of this section are below. When you close the Player Template, the last-viewed 
section will be shown the next time you open it.  

 

 

 

Edit Color Schemes: Clicking on this button will load the Colorizer that will allow you to customize 
the color of your Player by choosing from a set of ten predefined color schemes. In Articulate 
Presenter Professional Edition, you can customize the Player even further, creating your own color 
schemes.  
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Color Schemes: 

Articulate Presenter comes with a default color scheme and ten additional pre-configured color 
schemes: 

 Default (silver) 

 Blue deep 

 Blue light 

 Charcoal 

 Creamy 

 Green pharma 

 Green sci-fi 

 Gunship grey 

 Mocha bean 

 Red dawg 

 Southwestern 

You can choose the color scheme to apply to the template you are editing by selecting it from the 
Select a color scheme drop-down menu. When you are happy with your selection, click OK. The 
Color Scheme Editor will close and you will be taken back to the Player Template Builder. If you 
selected a different color scheme, you will be asked if you wish to save the template when you close 
the Player Template Builder. 
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Tip: You'll notice that the Color Scheme Editor is built on top of an Articulate-powered 
presentation. Navigate through the guide for details on how to use the Color Scheme Editor.  

  

Creating a new color scheme (Professional Edition Only): 

If you want to create a new color scheme, first select the pre-defined color scheme on which you 
wish to base your new design. Then click the New button and enter the name for your new color 
scheme: 

 

Click OK to save your new color scheme.  

 

Next, click on the Colorizer link in the upper right-hand corner (if the Colorizer has not already 
loaded).  

You should now see the custom COLOR SCHEME EDITOR: 

 

 

To edit a particular aspect of the Player, first click the bullet corresponding to the area of the Player 
you wish to modify. You will see the color palette reflect the current color. Next, modify the color 
using one of four methods to select your color of choice: 
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1. Use the visual palette. 

2. Specify the RGB numbers. 

3. Specify the HSL settings. 

4. Input the Hexadecimal (HTML) color code.  

When you're satisfied with your color selection, click Apply This Color. Repeat the above for each 
Player area whose color you wish to modify. When you are satisfied with your new color scheme, 
click OK to save the settings.  

Tip: For best results, have a professional designer create your custom color scheme. If 
that's not an option, use an online tool like the Sessions.edu Color Calculator to discover color 
harmonies.  

 

Additional Features of the Color Scheme Editor 

Slide 
dropshadow 

Add a shadow to the main slide content area.  

Slide list 
shadow 

Add a shadow to the list of presentation slides.  

Slidebar 
shadow 

Add a shadow to the slider next to the list of presentation slides.  
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Other 

Use the Other section of the Player Template Builder to configure additional player template 
options. Details of this section are below. When you close the Player Template, the last-viewed 
section will be shown the next time you open it.  

  

 

  

Elements of Other section: 

The elements of the Other section of the Player Template Builder are below. Use the checkbox or 
drop-down menu next to each element to select your choices for a given template.  

 

Other 

Display elapsed and 
total presentation 
time 

Controls whether the elapsed and total time of your presentation or e-
learning course should display.  

Loop presentation 

 

Controls whether the presentation or e-learning course should 
automatically start over from the beginning after the last slide is 
completed. This feature is useful for trade shows.  

Show slide notes 
button at bottom 

Controls whether the presenter slide notes should appear at the 
bottom of the Articulate Player. 

Open slide notes 
when presentation 
starts 

Controls whether slide notes should appear when launching an 
Articulate presentation. 
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Browser Window Settings 

Browser size 

Select from the drop-down menu the desired browser option. 

Display at user's current browser size: 

Do not change the user's browser size. 

Resize browser to optimal size: 

Resize the user's browser to 800 pixels wide x 550 pixels tall. 

Resize browser to fill screen: 

Maximize the user's browser to fill the screen.  

Presentation size 

Select from the drop-down menu the desired presentation size. 

Scale presentation to fill browser window: 

Enlarge the presentation to fill the user's browser.  

Lock presentation at optimal size: 

Lock the presentation at 800 pixels wide x 550 pixels tall. 

Launch 
presentation in new 
window (creates 
launch page) 

If checked, presentation will launch in a new window via a launch 
page. 

Display window with no browser controls: 

Wether or not to display browser controls (stop, refresh, forward, 
backward, etc.).  

Allow user to resize browser: 

Whether or not the user should be able to resize the browser 
containing the Articulate Player. 
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Publishing 

Publishing Your Presentation 

After you have added your Narration and made any desired edits, you are ready to Publish your 
presentation. 

To Publish your presentation: 

Click Publish from the Articulate menu in PowerPoint. 

   

 

The Publish Window will display.   

 
Publish Window – Publishing Options 

 

The Publish Window has the following six Publish options: 

Web: Select this option if you want to view your published presentation locally or are going to 
upload it to Web server on the Internet or intranet.  Also select this option if you want to FTP your 
published presentation directly to your server. 

LMS: Select this option if you plan to upload your presentation or e-learning course to a SCORM- or 
AICC-compliant Learning Management System.  

CD: Select this option if you will be distributing your published presentation via CD-ROM. 

Articulate Online: Coming soon.  

Word: Select this option to convert your presentation to Microsoft Word format as a Storyboard or 
Presenter Notes. 

Project Files: Select this option to publish and archive your source files (PowerPoint file, associated 
audio, images. etc.).  
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For more information about publishing options, please see the following help topics:   

• Publish for Web 

• Publish for LMS 

• Publish for CD 

• Publish to Articulate Online 

• Publish to Word 

• Publish Project Files 

 

Note: Articulate Presenter only supports the On-screen Show setting in PowerPoint. You 
can verify this setting in PowerPoint by going to File -> Page Setup -> Slides sized for. 
You can learn more here. 
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Publish for Web 

If you want to view your published presentation locally or are going to upload it to Web server on 
the Internet or intranet, or if you want to FTP your published presentation directly to your server, 
then follow the Publish for Web instructions below. 

 
Publish for Web 

 

 

Publish Location 

When you Publish for Web, you have two choices as to where you want to store your published 
presentation, a local folder/network share, or an FTP site. 

Publish to a Local Folder/Network Share: 

To publish to a local folder/network share, select Folder (the default) and: 

• manually type the path to the folder/network share, or  
• click the "..." button, navigate to the folder/network share, select it, and click OK 
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Publish to an FTP Site: 

To publish to an FTP site, select FTP site and provide the following information: 

Host The DNS/IP address of the FTP site. 

Username If the FTP site does not allow anonymous access, enter your Username. 

Port FTP servers generally use port 21. If more than one FTP site is being hosted 
on the same server, the port number may be different. For more information, 
check with your network administrator. 

Password If the FTP site does not allow anonymous access, enter your Password here. 

Dir If you want to publish to a specific folder/directory within the FTP site, enter 
the folder/directory name here. 

 

Properties 

In the Published title field, type the name for your published presentation.  

Choose a Player template by selecting from the drop-down menu one of the available default 
templates or one of your custom templates. Click the "..." button to launch the Player Template 
Editor. 

Choose a Logo by selecting from the drop-down menu one of your logos. Click the "..." button to 
launch the Logo Manager. 

Choose a Presenter by selecting from the drop-down menu one of the available presenters. Click 
the "..." button to launch the Presenter Manager. 

 

Output Options 

Check the box next to Zip to create a zip package of your published presentation.  

Check the box next to Email to publish your presentation, zip it, and attach the zip file to a new 
email.   

 

When you are finished with your choices, click Publish to publish your presentation. Next time you 
publish, your last-used selections will be saved.  

 

 
Publish for Web - Finish 

If you have chosen to publish to a local folder/network share, you will receive the following 
message: 

 

If you click Yes, your published presentation will automatically launch in the Articulate Player. If 
you click No, you can always launch your presentation later.  For more information on launching a 
published presentation, see Viewing Your Published Presentation.  

 



Publishing 

103 

If you have chosen to publish to an FTP site, you will be shown the upload status/number of bytes 
uploaded.   

When uploading is complete, you will see the following message: 

 

Your presentation will be uploaded to the FTP site. If you do not get the above message, verify that 
you have entered the correct authentication information and FTP server address.  
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Publish for LMS (Professional Edition Only) 

If you plan to upload your presentation or e-learning course to a SCORM- or AICC-compliant 
Learning Management System, then follow the Publish for LMS instructions below. 

 
Publish for LMS 

 

 

Publish Location 

When you Publish for LMS, you have two choices as to where you want to store your published 
presentation, a local folder/network share, or an FTP site. 

Publish to a Local Folder/Network Share: 

To publish to a local folder/network share, select Folder (the default) and: 

• manually type the path to the folder/network share, or  
• click the "..." button, navigate to the folder/network share, select it, and click OK 



Publishing 

105 

Publish to an FTP Site: 

To publish to an FTP site, select FTP site and provide the following information: 

Host The DNS/IP address of the FTP site. 

Username If the FTP site does not allow anonymous access, enter your Username. 

Port FTP servers generally use port 21. If more than one FTP site is being hosted 
on the same server, the port number may be different. For more information, 
check with your network administrator. 

Password If the FTP site does not allow anonymous access, enter your Password here. 

Dir If you want to publish to a specific folder/directory within the FTP site, enter 
the folder/directory name here. 

 

Properties 

In the Published title field, type the name for your published presentation.  

Choose a Player template by selecting from the drop-down menu one of the available default 
templates or one of your custom templates. Click the "..." button to launch the Player Template 
Editor. 

Choose a Logo by selecting from the drop-down menu one of your logos. Click the "..." button to 
launch the Logo Manager. 

Choose a Presenter by selecting from the drop-down menu one of the available presenters. Click 
the "..." button to launch the Presenter Manager. 

Choose the communication standard supported by the LMS where you will upload your published 
presentation or e-learning course. Available options are SCORM 1.2, SCORM 2004, or AICC (check 
with your LMS provider if you are unsure which standard to use). Additionally, Articulate Knowledge 
Portal customers can use the AKP option to publish directly to the Portal (see below section, AKP 
Options, for more details). Click the Reporting and tracking... button to specify metadata that will 
be stored in your LMS.  
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Input the metadata that will be sent to your LMS for this course. If you are unsure of any settings, 
check with your LMS provider. 
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You have a choice in determining how your course will be deemed completed by your LMS. Your 
choices are the following: 

• Track Using Number of Slides Viewed. With this option selected, your user must view a 
set number of the total slides in the presentation before the user is considered to have 
completed the course.  Simply pick a number from the drop-down box next to Minimum 
number of slides viewed to complete. In the screen shot above, the viewer is required 
to view all 13 slides before the course is considered by your LMS to be complete. 

• Track Using Quiz Results. With this option selected, your user must successfully 
complete a Quizmaker quiz  or choices Learning Game before the user is considered to 
have completed the course. For more information on quizzes, see the section on Adding 
Quizzes and Learning Games. If you have inserted more than one quiz in your e-learning 
course or presentation, only one can be chosen for tracking purposes by your LMS.    

When you are satisfied with your LMS metadata settings, click OK to save your settings and return 
to the publish screen. 
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AICC Options 

This screen will contain information required by your LMS. The LMS Course Information Title and 
Identifier fields will automatically be filled in and defaults to the name of your presentation. The 
Filename (URL) field must be set in advance to the URL of the server from which you will be 
serving your presentation.  Consult the manual for the LMS you are using for a description of how 
the LMS Course Information Description and Creator fields are used.   

Tip: The location of the server is stored in the course.au file; if the location of the server 
changes after the presentation is published, this file can be edited via Notepad or another text 
editing tool to reflect the new location. You can find the course.au file in the AICC Course Files 
folder within the Publish Location folder.  

 

Output Options 

Check the box next to Zip to create a zip package of your published presentation. This box is 
checked by default since most LMSes require that you upload a zipped SCORM or AICC package.  

Check the box next to Email to publish your presentation, zip it, and attach the zip file to a new 
email.   

 

When you are finished with your choices, click Publish to publish your presentation or e-learning 
course. Next time you publish, your last-used selections will be saved.  

 

 
Publish for LMS – Finish 

If you have chosen to publish to a local folder/network share, you will receive the following 
message: 

 

If you click Yes, your published presentation will automatically launch in the Articulate Player. If 
you click No, you can always launch your presentation later.  For more information on launching a 
published presentation, see Viewing Your Published Presentation.  

 

If you have chosen to publish to an FTP site, you will be shown the upload status/number of bytes 
uploaded.   

When uploading is complete, you will see the following message: 

 

Your presentation will be uploaded to the FTP site.  If you do not get the above message, verify that 
you have entered the correct authentication information and FTP server address.  
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Publish to Articulate Knowledge Portal (Knowledge Portal Customers Only) 

If you've selected the option to publish to your Articulate Knowledge Portal account, after 
publishing, you'll be prompted to input the following account details (note that you must first enable 
the setting in Library and Options): 

• Server URL: The full URL of your Knowledge Portal account (e.g., 
http://<account_name>.articulateglobal.com).  

• Username: The username of a user with account permission to upload to your Repository, 
usually an administrator account. 

• Password: The password for the specified username. 

 

 



Articulate Presenter v5 Documentation 

110 

After inputting your account details, click OK. You'll then be prompted to select a location in your 
Repository where the uploaded presentation or e-learning course should go. After selecting a 
location, click OK and the upload will begin. 

 

You can click the Manage Accounts link to Add, Edit, or Delete your Knowledge Portal account 
details. 
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Publish for CD 

If you want to deliver your presentation via CD-ROM distribution, then follow the Presentation for 
CD-ROM Delivery instructions below. 

 
Publish for CD 

 

 

Publish Location 

Publish to a Local Folder/Network Share: 

To publish to a local folder/network share, next to Folder: 

• manually type the path to the folder/network share, or  
• click the "..." button, navigate to the folder/network share, select it, and click OK 

 

Properties 

In the Published title field, type the name for your published presentation.  

Choose a Player template by selecting from the drop-down menu one of the available default 
templates or one of your custom templates. Click the "..." button to launch the Player Template 
Editor. 

Choose a Logo by selecting from the drop-down menu one of your logos. Click the "..." button to 
launch the Logo Manager. 

Choose a Presenter by selecting from the drop-down menu one of the available presenters. Click 
the "..." button to launch the Presenter Manager. 
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Output Options 

Check the box next to Zip to create a zip package of your published presentation.  

Check the box next to Create autorun files to allow your presentation to play automatically when 
inserted into a computer. This option is checked by default. More on this here. 

 

When you are finished with your choices, click Publish to publish your presentation. Next time you 
publish, your last-used selections will be saved.  

 

 
Publish for CD - Finish 

When your publishing is complete, you will receive the following message: 

 

If you click Yes, your published presentation will automatically launch in the Articulate Player. If 
you click No, you can always launch your presentation later.  For more information on launching a 
published presentation, see Viewing Your Published Presentation.  

 



Publishing 

113 

Publish to Articulate Online (Professional Edition Only) 

If you have an Articulate Online trial or paid account and wish to publish content directly to your 
account, then follow the Publish to Articulate Online instructions below. 

 
Publish to Articulate Online 

 

 

Properties 

In the Published title field, type the name for your published presentation.  

In the Description field, type a description for your published presentation that will appear along 
with the presentation in your Articulate Online account. 

Choose a Player template by selecting from the drop-down menu one of the available default 
templates or one of your custom templates. Click the "..." button to launch the Player Template 
Editor. 

Choose a Logo by selecting from the drop-down menu one of your logos. Click the "..." button to 
launch the Logo Manager. 

Choose a Presenter by selecting from the drop-down menu one of the available presenters. Click 
the "..." button to launch the Presenter Manager. 

Click the Reporting and tracking... button to determine how your course's status will be tracked 
and deemed complete by Articulate Online.  
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Reporting 

Select from the drop-down the option you would like Articulate Online to use in reporting the status 
of this e-learning course or presentation. Options include the following: 

 

• Passed/Incomplete  

• Passed/Failed 

• Completed/Incomplete 

• Completed/Failed 

Tracking 

Your choices are the following: 

• Track Using Number of Slides Viewed. With this option selected, your user must view a 
set number of the total slides in the presentation before the user is considered to have 
completed the course.  Simply pick a number from the drop-down box next to Minimum 
number of slides viewed to complete. In the screen shot above, the viewer is required 
to view all 4 slides before the course is considered by Articulate Online to be complete. 

• Track Using Quiz Results. With this option selected, your user must successfully 
complete a Quizmaker quiz  or choices Learning Game before the user is considered to 
have completed the course. For more information on quizzes, see the section on Adding 
Quizzes and Learning Games. If you have inserted more than one quiz in your e-learning 
course or presentation, only one can be chosen for tracking purposes by Articulate Online. 
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Articulate Presenter will default to track using quiz results if you have a quiz embedded in your 
content.  

When you are satisfied with your settings, click OK to save your settings and return to the publish 
screen. 

 

Account Information 

In order to Publish to Articulate Online, you must already have an existing account. You can 
learn more about Articulate Online, including how to create a free 30-day trial account or how to 
purchase a paid account, here: 

http://www.articulate.com/articulate_online.html 

 

Account URL The full URL of your account. The subdomain is unique to your account. The 
format should be http://<accountname>.articulate-online.com. If you have a 
professional-level account, you might also have a custom root-level domain. If 
so, input that here. For example, http://<accountname>.elearningserver.com. 

E-mail: The administrator e-mail address/login associated with your account 

Password: The password you selected when you created your account, or the current 
password if you've changed it.  

Save my 
password: 

Check this box to save your password for subsequent publishing to your 
Articulate Online account. 

 

When you are finished with your choices, click Publish to publish your presentation or e-learning 
course. Next time you publish, your last-used selections will be saved.  

 

 
Publish to Articulate Online – Finish 

After you begin publishing to Articulate Online, Articulate Presenter will automatically upload your 
e-learning course or presentation to your account. 
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When the upload is complete, you will have the option to launch your Web browser to view or 
manage the content item in your Articulate Online account. The checkmark is selected by default, so 
click OK to view, or uncheck the box and click OK to complete the publishing/upload process. Your 
selection will be remembered the next time you publish. 
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Manually Publishing to Articulate Online 

If you are unable to connect to Articulate Online because of a corporate or local firewall you can 
manually publish and upload your documents to Articulate Online. 

1. In PowerPoint, go to Articulate -> Library and Options -> Other. 
2. Select the option to Enable publish for manual uploading to Articulate Online. 
3. Click OK. 

 

4. Go to Articulate -> Publish -> LMS. 
5. Under Properties, select from the LMS dropdown menu AO. 
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6. Click Reporting and Tracking to set options as you’d like.  
7. Click OK to save E-learning Options. 
8. Click Publish. 
9. Click Yes when prompted to view the published output in your AO folder. 
10. Your file will now be ready to upload to Articulate Online and should have a .art5 extension. 
11. To learn how to upload your .art5 file to Articulate Online, see How do I upload manually? 
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Publish to Word  

If you want to export a Storyboard or presenter notes to Microsoft Word, then follow the Publish to 
Word instructions below. 

 
Publish to Word 

 

 

Publish Location 

To publish to a local folder/network share, next to Folder: 

• manually type the path to the folder/network share, or  
• click the "..." button, navigate to the folder/network share, select it, and click OK 

 

Properties 

In the Published title field, type the name for your published presentation.  

Choose a Presenter by selecting from the drop-down menu one of the available presenters. Click 
the "..." button to launch the Presenter Manager. 

Select from the drop-down list your desired Output type, Storyboard or Presenter Notes. 

 

 
 

Depending on how much information you require, you can export presentation information to 
Microsoft Word in one of the following formats: 
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Word Storyboard:  This is the most detailed format, and provides the following information: 

     Presentation data 

     Presenter data 

     Slide data 

     Slide thumbnails 

     Slide notes 

     Interactions questions and answers 

     Web Object information 

     Inserted Flash movie information 

Presenter Notes:  This exports the presenter notes only. 

 

 
 

Output Options 

Check the box next to Zip to create a zip package of your published presentation.  

Check the box next to Email to publish your presentation, zip it, and attach the zip file to a new 
email.   

 

When you are finished with your choices, click Publish; the export process will begin. When 
finished, Microsoft Word will open a new document with your presentation Storyboard or Notes. 
Next time you publish, your last-used selections will be saved.  
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Publish Project Files 

If you wish to publish and archive your source files (PowerPoint file, associated audio, images. etc.), 
follow the instructions below to Publish Project Files. 

 

 

Publish Location 

When you Publish Project Files, you have two choices as to where you want to store your 
published presentation, a local folder/network share, or an FTP site. 

Publish to a Local Folder/Network Share: 

To publish to a local folder/network share, select Folder (the default) and: 

• manually type the path to the folder/network share, or  
• click the "..." button, navigate to the folder/network share, select it, and click OK 

Publish to an FTP Site: 

To publish to an FTP site, select FTP site and provide the following information: 

Host The DNS/IP address of the FTP site. 

Username If the FTP site does not allow anonymous access, enter your Username. 

Port FTP servers generally use port 21. If more than one FTP site is being hosted 
on the same server, the port number may be different. For more information, 
check with your network administrator. 

Password If the FTP site does not allow anonymous access, enter your Password here. 

Dir If you want to publish to a specific folder/directory within the FTP site, enter 
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the folder/directory name here. 

 

Properties 

In the Published title field, type the name for your published presentation.  

 

Output Options 

You can only create a Zip package of your published presentation. This option is checked by default 
and you cannot uncheck it. To email your zip package, check the box next to Email. If you'd like to 
include your source (uncompressed) audio files in your project files, check the box next to Include 
.WAV files. 

 

When you are finished with your choices, click Publish to publish your project files. Next time you 
publish, your last-used selections will be saved.  

 

 
 

Publish Project Files – Finish 

When your presentation is published and zipped, you will receive the message below asking if you'd 
like to view the folder containing your Zip file: 

 

Clicking Yes will open the folder containing your zipped project files. Clicking No will return you to 
PowerPoint. 
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Viewing Your Published Presentation 

If your open presentation has been previously published, you can easily view it at any time.  

To view your previously published presentation: 

1.  Select Articulate from the PowerPoint menu bar. 

2. Select View Presentation from the Articulate Menu. 

 

 

 

If you have not yet published your presentation, the following message will appear: 

 

 

If your presentation has been previously published, you will receive the following message: 
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You can also view your presentation at any time by navigating to the output location and double-
clicking player.html or launcher.html.  
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Additional Information 

Articulate Software End-User License Agreement  

 

NOTICE:  READ THIS END-USER LICENSE AGREEMENT CAREFULLY BEFORE 
INSTALLING, ACCESSING, COPYING OR USING THE SOFTWARE ACCOMPANYING THIS 
AGREEMENT.  CLICKING ON THE "I ACCEPT" BUTTON BELOW, OR IN ANY OTHER WAY 
INSTALLING, ACCESSING, COPYING OR USING THE SOFTWARE, CREATES A LEGALLY 
ENFORCEABLE CONTRACT AND CONSTITUTES ACCEPTANCE OF ALL TERMS AND 
CONDITIONS OF THIS AGREEMENT WITHOUT MODIFICATION. 

RETURN:  IF YOU ARE NOT AUTHORIZED TO ENTER INTO THIS AGREEMENT, OR IF YOU 
DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, THEN YOU MUST CLICK 
ON THE "CANCEL" BUTTON BELOW, AND YOU MUST NOT INSTALL, ACCESS, COPY OR 
USE THE SOFTWARE, AND YOU MUST, WITHIN 3 DAYS, DELETE AND PERMANENTLY 
ERASE FROM ALL COMPUTER MEMORIES AND STORAGE MEDIA ALL COPIES OF THE 
SOFTWARE AND DOCUMENTATION, AND TO OBTAIN A REFUND, YOU MUST NOTIFY 
LICENSOR IN WRITING THAT YOU HAVE COMPLIED WITH THE FOREGOING. 

 

 

This End-User License Agreement (the Agreement), effective as of the date you accept the terms 
hereof (unless returned as specified above, the Effective Date), is entered into between Articulate 
Global, Inc., a Delaware corporation, with an address at 244 5th Avenue, Suite 2960, New York, NY 
10001 USA (Licensor) and Licensee.  The parties agree as follows: 

 

1.  DEFINITIONS. 

Documentation means the user guide, help information and/or other documentation provided by 
Licensor with the Software. 

Licensee  means the User, together with the business or other entity for which the Software is 
obtained. 

Software  means any Licensor computer program (in object code) accompanying this Agreement. 

Updates  means, if applicable, any patch, update or new version of the Software delivered to 
Licensee pursuant to the Support Services. 

User  means you, the individual who accepts this Agreement, not any other person. 

2.  LICENSE. 

2.1  Software.  Subject to all terms and conditions in this Agreement, Licensor grants Licensee a 
nonexclusive, nontransferable, nonsublicenseable right and license to have the User use the 
Software and Documentation without modification. 

2.2  Limitations.  User may use 1 copy of the Software solely for Licensee's internal business 
purposes, and only on 1 computer.  However, subject to the same use limitations and restrictions, 
User may make a second copy and install it either on a portable or on a home computer under his 
or her control, provided that:  (a) both copies of the Software are not used at the same time, and 
the portable/home computer copy is used solely as allowed for such version or edition (e.g., 
educational use only); and (b) the second copy of the Software is not installed or used after the 
time such User is no longer the primary user of the computer on which the primary copy of 
Software is installed.  To activate a second copy as provided in this Section 2.2, User must send an 
email request (including his/her product key) to support@articulate.com. 

2.3  License Control.  Licensee acknowledges that the Software may contain code or require 
devices that detect or prevent unauthorized use of, or disable, the Software. 

3.  SUPPORT SERVICES. 

3.1  Support.  If and only if Licensee has ordered and paid for a Platinum Membership Plan or 
other support plan, Licensor will use commercially reasonable efforts to provide Licensee with 
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Software maintenance and support in accordance with its standard practices (as amended from time 
to time, Support Services).  Licensor shall have no obligation to support any version other than 
the then current and immediate prior version.  Licensee agrees that Licensor may charge in 
accordance with its then current policies for any support services resulting from (a) problems, errors 
or inquiries relating to any hardware, system, service or other software or (b) use of any 
unsupported version of the Software. 

3.2 Updates.  Licensor will provide Licensee with any Update that it makes generally available to 
its other licensees which have purchased the same level of support.  Any Update delivered by 
Licensor shall be treated as Software for all purposes under this Agreement. 

4.  CONFIDENTIALITY. 

4.1  Scope.  The term Confidential Information means all trade secrets, know-how, software 
and other financial, business or technical information of Licensor or any of its suppliers that is 
disclosed by or for Licensor in relation to this Agreement, but not including any information Licensee 
can demonstrate is (a) rightfully furnished to it without restriction by a third party without breach of 
any obligation to the Licensor, (b) generally available to the public without breach of this Agreement 
or (c) independently developed by it without reliance on such information.  All Software and 
Documentation is Confidential Information. 

4.2  Confidentiality.  Except for the specific rights granted by this Agreement, Licensee shall not 
possess, use or disclose any Confidential Information without Licensor's prior written consent, and 
shall use reasonable care to protect the Confidential Information.  Licensee shall be responsible for 
any breach of confidentiality by its employees. 

5.  PROPRIETARY RIGHTS. 

5.1  Restrictions.  Licensee shall not (a) use any Confidential Information to create any software 
or documentation that is similar to any Software or Documentation, (b) disassemble, decompile, 
reverse engineer or otherwise try to discover any source code or underlying structures, ideas or 
algorithms of the Software (except and only to the extent these restrictions are expressly prohibited 
by applicable statutory law), (c) encumber, lease, rent, loan, sublicense, transfer or distribute any 
Software, (d) copy, adapt, merge, create derivative works of, translate, localize, port or otherwise 
modify any Software or Documentation, (e) use the Software in an automated process, (f) use the 
Software, or allow the transfer, transmission, export or re-export of all or any part of the Software 
or any product thereof, in violation of any export control laws or regulations of the United States or 
any other relevant jurisdiction or (g) permit any third party to engage in any of the foregoing 
proscribed acts.  Licensee shall not use the Software for the benefit of any third party (e.g., time-
share or service bureau arrangement) without Licensor's prior written consent, at its discretion. 

5.2  No Implied License.  Except for the limited rights and license expressly granted hereunder, 
no other license is granted, no other use is permitted and Licensor (and its suppliers) shall retain all 
right, title and interest in and to the Software and Documentation (and all patent rights, copyright 
rights, trade secret rights and all other intellectual property and proprietary rights embodied 
therein). 

5.3  Markings.  Licensee shall not alter, obscure or remove any trademark, patent notice or other 
proprietary or legal notice displayed by or contained in any Software, Documentation or packaging. 

5.4  Third Party Software.  The Software may operate or interface with software or other 
technology (In-Licensed Code) that is in-licensed from, and owned by, third parties (Third Party 
Licensors).  Licensee agrees that (a) it will use In-Licensed Code in accordance with this Agreement 
and any other restrictions specified in the applicable license set forth or referenced in the 
Documentation, (b) no Third Party Licensor makes any representation or warranty to Licensee 
concerning the In-Licensed Code or Software and (c) no Third Party Licensor will have any 
obligation or liability to Licensee as a result of this Agreement or Licensee's use of the In-Licensed 
Code. 

6.  WARRANTY DISCLAIMERS. 

THE SOFTWARE AND SUPPORT SERVICES ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY 
KIND.  LICENSOR DOES NOT WARRANT THAT THE SOFTWARE OR SUPPORT SERVICES WILL MEET 
LICENSEE'S REQUIREMENTS OR THAT THEY WILL BE UNINTERRUPTED OR ERROR-FREE.  TO THE 
FULLEST EXTENT PERMITTED BY LAW, LICENSOR HEREBY DISCLAIMS (FOR ITSELF AND ITS 
SUPPLIERS) ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, ORAL OR WRITTEN, WITH 
RESPECT TO THE SOFTWARE AND SUPPORT SERVICES INCLUDING, WITHOUT LIMITATION, ALL 
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IMPLIED WARRANTIES OF TITLE, NON-INFRINGEMENT, QUIET ENJOYMENT, INTEGRATION, 
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE AND ALL WARRANTIES ARISING 
FROM ANY COURSE OF DEALING, COURSE OF PERFORMANCE OR USAGE OF TRADE. 

7.  LIMITATION OF LIABILITY. 

IN NO EVENT SHALL LICENSOR (OR ITS SUPPLIERS) BE LIABLE CONCERNING THE SUBJECT 
MATTER OF THIS AGREEMENT, REGARDLESS OF THE FORM OF ANY CLAIM OR ACTION (WHETHER 
IN CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHERWISE), FOR ANY (A) MATTER BEYOND 
ITS REASONABLE CONTROL, (B) LOSS OR INACCURACY OF DATA, LOSS OR INTERRUPTION OF 
USE, OR COST OF PROCURING SUBSTITUTE TECHNOLOGY, GOODS OR SUPPORT SERVICES, (C) 
INDIRECT, PUNITIVE, INCIDENTAL, RELIANCE, SPECIAL, EXEMPLARY OR CONSEQUENTIAL 
DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF BUSINESS, REVENUES, PROFITS OR 
GOODWILL, OR (D) AGGREGATE DAMAGES, IN EXCESS OF THE AMOUNT PAID TO LICENSOR FOR 
THE SOFTWARE OR SUPPORT SERVICE THAT GAVE RISE TO THE CLAIM DURING THE PRIOR 12-
MONTH PERIOD, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
 THESE LIMITATIONS ARE INDEPENDENT FROM ALL OTHER PROVISIONS OF THIS AGREEMENT AND 
SHALL APPLY NOTWITHSTANDING THE FAILURE OF ANY REMEDY PROVIDED HEREIN. 

8.  TERM AND TERMINATION. 

8.1  Term.  This Agreement shall commence on the Effective Date and continue in effect until 
terminated as provided herein. 

8.2  Termination.  Licensee may terminate this Agreement at any time for its convenience upon 
written notice to Licensor.  This Agreement shall automatically terminate without further action by 
any party, immediately upon any material breach by Licensee of any limitation or restriction set 
forth in Section 2.2 or 5.1. 

8.3  Effects of Termination.  Upon termination of this Agreement for any reason, all rights, 
obligations and licenses of the parties hereunder shall cease, except that (a) all obligations that 
accrued prior to the effective date of termination and any remedies for breach of this Agreement 
shall survive any termination, (b) Licensee shall promptly return or destroy all Software and other 
tangible Confidential Information, and permanently erase all Confidential Information from any 
computer and storage media and (c) the provisions of Sections 4 (Confidentiality), 5 (Proprietary 
Rights), 6 (Warranty Disclaimers), 7 (Limitation of Liability), 9 (General Provisions) and this Section 
8 shall also survive. 

9.  GENERAL PROVISIONS. 

9.1  Entire Agreement.  This Agreement constitutes the entire agreement, and supersedes all 
prior negotiations, understandings or agreements (oral or written), between the parties about the 
subject matter of this Agreement.  Terms set forth in Licensee's Purchase Order (or any similar 
document) that are in addition to or at variance with the terms of this Agreement are specifically 
waived by Licensee.  All such terms are considered to be proposed material alternations of this 
Agreement and are hereby rejected.  No waiver, consent or modification of this Agreement shall 
bind either party unless in writing and signed by the party against which enforcement is sought. 
 The failure of either party to enforce its rights under this Agreement at any time for any period will 
not be construed as a waiver of such rights.  If any provision of this Agreement is determined to be 
illegal or unenforceable, that provision will be limited or eliminated to the minimum extent 
necessary so that this Agreement will otherwise remain in full force and effect and enforceable. 

9.2  Governing Law.  This Agreement shall be governed by and construed in accordance with the 
laws of the State of New York, without regard to its conflicts of law provisions. 

9.3  Remedies.  Unless specifically provided otherwise, each right and remedy in this Agreement is 
in addition to any other right or remedy, at law or in equity.  Licensee agrees that, in the event of 
any breach or threatened breach of Section 4 or 5, Licensor will suffer irreparable damage for which 
there is no adequate remedy at law.  Accordingly, Licensor shall be entitled to injunctive and other 
equitable remedies to prevent or restrain such breach or threatened breach, without the necessity 
of posting any bond. 

9.4  Notices.  Any notice or communication hereunder shall be in writing and either personally 
delivered or sent via confirmed facsimile, recognized express delivery courier or certified or 
registered mail, prepaid and return receipt requested.  Notices shall be delivered to the address 
specified by Licensee when the Software was ordered, or to the address above for Licensor, as the 
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case may be, or at such other address designated in a subsequent notice.  All notices shall be in 
English, effective upon receipt. 

9.5  Assignment.  This Agreement and the rights and obligations hereunder are personal to 
Licensee, and may not be assigned or otherwise transferred, in whole or in part, without Licensor's 
prior written consent.  Any attempt to do otherwise shall be void and of no effect.  Without 
Licensee's consent, Licensor may assign this Agreement to any third party.  This Agreement shall be 
binding upon, and inure to the benefit of, the successors, representatives and permitted assigns of 
the parties. 

9.6  Independent Contractors.  The parties shall be independent contractors under this 
Agreement, and nothing herein will constitute either party as the employer, employee, agent or 
representative of the other party, or both parties as joint venturers or partners for any purpose. 

9.7  License to the Government.  If any user of the Software or Documentation is a department, 
agency or other entity of the United States Government, the use, duplication, reproduction, 
modification, release, disclosure or transfer of the Software and Documentation is restricted in 
accordance with FAR 12.212 for civilian agencies and DFAR 227.7202 for military agencies.  The 
Software is commercial computer software and the Documentation is commercial computer software 
documentation, and their use is further restricted in accordance with the terms of this Agreement. 

9.8  Basis of Bargain.  EACH PARTY RECOGNIZES AND AGREES THAT THE WARRANTY 
DISCLAIMERS AND LIABILITY AND REMEDY LIMITATIONS ARE MATERIAL BARGAINED-FOR BASES 
OF THIS AGREEMENT AND THAT THEY HAVE BEEN TAKEN INTO ACCOUNT BY EACH PARTY AND 
REFLECTED IN DETERMINING THE CONSIDERATION TO BE GIVEN BY EACH PARTY HEREUNDER 
AND IN THE DECISION TO ENTER INTO THIS AGREEMENT. 

9.9  Acknowledgment.  Licensee acknowledges that (a) it has read and understands this 
Agreement, (b) it has had an opportunity to have its legal counsel review this Agreement, (c) this 
Agreement has the same force and effect as a signed agreement, (d) Licensor requires identification 
of the User and Licensee before issuing this license and (e) issuance of this license does not 
constitute general publication of the Software or any other Confidential Information. 
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Contact 

 

Address: Articulate 
244 5th Ave. Suite 2960 
New York, NY 10001 

 

World Wide Web: www.articulate.com 

 

Articulate Support 
Online 

support.articulate.com 

Email: support@articulate.com 

 

Support Hours: 9:00am to 5:00pm (GMT -5) Monday - Friday 
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Using this Help System 

Finding information in the Help 

You can find information in the Help in several ways. 

 

To find information in the online Help: 

1. From the Help menu, click Contents & Index. 

2. If the left-hand pane isn't visible, click the Contents, Index, or Search buttons.  

3. In the Help window, do the following: 

Click: To: 

Contents View the table of contents for the online Help. Click each book to 
display pages that link to topics, and click each page to display the 
corresponding topic in the right pane. 

Index  Search for specific words or phrases, or select from a list of index 
keywords. Click the keyword to display the corresponding topic in the 
right pane.  

Search  Locate words or phrases within the content of your topics. Type the 
word or phrase in the text field, press ENTER, and select the topic 
you want from the list of topics. 
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Printing the Help 

 

While using Articulate Online Help, you can print topics and information directly from the browser 
window.  

  

To print a Help topic: 

1. Right-click in the right pane and select Print. The Print dialog opens. 

2. Click Print. The topic is printed to the specified printer. 
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